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1 Summary of the Axxon PSIM utilities

Additional Axxon PSIM software utilities are separate software applications intended to perform additional
operations when setting up and working with Axxon PSIM software. This document describes the following utilities:

=

=
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COPNIONRWN

The utility for reading video capture card code and dongle

Converter.exe utility for converting video and audio archives

Tweaki.exe utility for advanced setup of the Axxon PSIM software system

The utility for collecting configuration data on servers and RWS for the Technical Support
The Fps.exe utility for productivity estimation

The SignCheck.exe utility for checking the authenticity of exported frames

The Convert.exe utility for correcting modification dates of video archives

The ddi.exe utility for editing database templates and external settings files

The Arpedit.exe utility for creating user dialog windows

The idb.exe utility for converting databases, selecting database templates and making backup copies of
databases

. Configuration check tool

. Index.exe utility for reindexing archive files

. The shedule.exe utility for creating a replication query file

. The Axxon Player utility for viewing and converting the video archive
. The Cam_title_updater.exe utility to convert titles database

Summary of the Axxon PSIM utilities- 7
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2 The utility for reading video capture card code and dongle

2.1 The purpose of the CodeReader.exe utility

The CodeReader.exe utility is designed to read the dallas code of the cryptochip (chip) of the video capture card,
which determines the card type, HID of computer and the number of the Guardant dongle.

() Note.

For proper operation of the utility Axxon PSIM™ is to be shut down.

2.2 Starting and shutting-down the utility

To start the CodeReader.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start, then All Programs, then Axxon PSIM, then Tools,
then Read hardware codes. The CodeReader.exe utility is available for the following types of Axxon PSIM™
installation: Server and Remote Admin Workstation.
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2. Start the utility from the Tools folder of the Axxon PSIM folder. Example: C:\ Program Files\Axxon

PSIM\Tools\CodeReader.exe.
The Code Reader dialog box will open.

ﬂ Advanced setkings ukility
Create dialog windows

E‘ Video player and file corverter
m Check digital signature
H Frstest

(DS Read hardw.

il [ead Matrix codes

[ Restore il system indexes
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To shut down the CodeReader.exe utility, click the X putton.

2.3 Using the CodeReader.exe utility

The CodeReader.exe utility allows determining the type of installed video capture card by its dallas code(s), HID of
computer, as well as the number of the Guardant dongle. To read this information, start the utility (see the Starting
and shutting-down the utility section). The type of video capture card, its dallas code(s) and the number of the
Guardant dongle and HID will be displayed in the Code Reader dialog box.

DS Code Reader

x|
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3

|»
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The number of dallas codes depends on the number of chips on the video capture card. Figure shows that the FS6

card with 4 chips has been used.
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2.4 Portable version CodeReader_portable.exe

The portable version of the utility for reading the video capture card codes and dongles is the executable file
CodeReader_portable.exe. This file can be downloaded from the official AxxonSoft website.

The CodeReader_portable.exe file can be launched on any computer even without Axxon PSIM installed.

& Attention!

For the portable version of the utility to operate, you need to install the latest versions of the Visual C++

redistributable packages for Visual Studio.

To check the availability of the Visual C++ redistributable packages for Visual Studio, select Start ->

Control Panel -> Programs -> Programs and Features.

£]l Programs and Features - O X
&« v 4% 3l » Control Panel » Programs > Programs and Features v L Search Programs an... P
Control Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then dick Uninstall, Change, or Repair.
E; Turn Windows features on or
off Organize ~ E= ~ o
Name - Publisher ~

[®] Microsoft Visual C++ 2005 Redistributable

Microsoft Visual C++ 2008 Redistributable - x64 9.0.30729.17
[® Microsoft Visual C++ 2008 Redistributable - x86 9.0.30729.17
[®] Microsoft Visual C++ 2010 x64 Redistributable - 10.0.40219

Microsoft Visual C++ 2010 x86 Redistributable - 10.0.40219

mgMicrosoft Visual C++ 2013 Redistributable (x64) - 12.0.30501
@Microsof‘t Visual C++ 2013 Redistributable (x86) - 12.0.30501

EgMicrosoft Visual C++ 2015-2019 Redistributable (x64) - 14.29....

Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation

Microsoft Corporation

0!-) Microsoft Visual Studio Installer

v Microsoft Visual Studio Tools for Applications 2017
& Microsoft Web Deploy 4.0

23 Movavi Screen Recorder 22

<

Currently installed programs Total size: 17,8 GB
107 programs installed

8]

\ mgMicrosof‘t Visual C++ 2015-2022 Redistributable (x86) - 14.31....
icrosoft Visual Studio Code (User)

Microsott (_orpora-hon
Microsoft Corporation
Microsoft Corporation
Microsoft Corporation

Movavi

If there are no redistributable packages, you can download them from the official website at: https://
learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170, or install the file that
is available in Axxon PSIM installation directory in the Redist -> Dotnet4.5 folder.

The purpose and interface of the portable version, as well as the procedure for working with it are similar to the
standard version of the CodeReader.exe utility - see The utility for reading video capture card code and dongle.

The utility for reading video capture card code and dongle- 10


https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

3 Converter.exe utility for converting video and audio archives

3.1 The purpose of the Converter.exe utility

& mportant!
Correct operation of the Converter.exe utility on Windows 10 and newer OSes is not guaranteed.
The Conveter.exe utility is designed to play video and audio archives, and to convert them to standard formats:
MPEG, DivX, etc.
Besides video and audio playback, Converter.exe utility is used for:

1. converting audio and video files;
2. copying the files from the archive to another folder with no data loss.

() Note.

If video and audio were synchronized at the time of recording, the converted video file will contain sound
track.

The utility can be started from the Tools folder of the Axxon PSIM program folder or from the Start menu: Start ->
Programs -> Axxon PSIM -> Utilities -> Playback and Conversion.

The utility dialog box is shown in the figure.

=10l |

2fE] | — =]

@]15.01.2009j| 9:41:27 =5 |[16.01.2008 || 9:46:06 j%
ICamera jIE j@|«|>|"|.|»| §|E§‘.|ﬁ|

Converter.exe utility for converting video and audio archives- 11
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3.2 Starting and shutting-down the Converter.exe utility
To start the Converter.exe utility, do one of the following:

1. Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Utilities,
then Playback and Conversion. The Converter.exe utility is available from the Start menu with the

following installation types of the Axxon PSIM software: Server, Remote administrator workstation, Remote
client.

[T Database compression utility
Database updating ukility
[ Database viewing utility

u Digital signature checking utility
H Frs testing utility

Ui Hardware codes reading utiliey

Set Program Access and Defaults
Main syskem's bweaking ukility

Matrix codes reading utility

7% Search of IP devices

" Windows Catalog

Sindows Update

3.U Sound syskerm's bweaking ukilicy

WinZip @ System's configuration ukility

BiemeE I Accessories »

IFF) ACD Systems 3
Documents L @ Microsoft Office 3 ﬁ Administrator guide

- - >
PrinkMe Inkernet Printing  » Intellect

Settings 3 @ & »l

I winzip » T Operator quide
Search 3 @ Snaglk 8 b e System's infarmation utility

[@ QIP 2005 3 Q& System's report ukility

Help and Suppart

¥

Run...

E Shut Dawr, .

2. Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon
PSIM\Tools\converter.exe.

Archive Converter dialog box will open.
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o Archive's converter -0l x|

2l ] =
@|m.n1.znngj| a4:27 = O 16012009 ¥ | sidei0e j@
ICamera jIE j@|«|’|“|.|»| §|ﬁi|ﬁ|

To close the Converter.exe utility, either click the cross button in the top right corner of the dialog box, or press
Alt+F4 on the keyboard.
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&% Archive Converter A@

= Restore
Mowe

Size
= [Mimimize
O Maximize 2

Alt+F4 |

2F] | =8|

@h?.na.znngjhs:n&%ﬁ 9 f17.06.2008 | [13005:46 j@
camers 1| =] 8] D> [0y & il

3.3 Converter.exe interface

3.3.1 The Archive's Converter dialog box

The dialog box of the converter.exe utility is shown in the figure.
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i

%o |[16.01.2008 >|| o127 5 [16.00.2000 7| oaeins = B
A Cal«r sy sag

The Archive's Converter dialog box comprises of the following elements:

1. The screen to play back recordings (1);
2. The control panel for video and audio recordings playback (2).
The elements of the control panel are described in the table.

10 8 10

11(2 )& = =i )12
3 16.01.2009 = || 94127 = 16.01.2009 = || 9:46:06 2=
@amera 5& he } NN =3 ;
4 ) 6 i 13 14 15
Ne Element name Description
1 Recording start date and time Fields for entering the approximate start date and time of the
video or audio recording

2 Recording end date and time Fields for entering the approximate end date and time of the

video or audio recording
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10

11

12

13

14

Element name

Go to first / last frame

Device

Device number

Search

Playback panel

Time scale

Export setup

Exported recording limits

Hide/show the list

Add to list

Print frame

Frame export

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Buttons for quick moving of the slider to the beginning or the
end of the recording

Drop-down list field for selecting the device (camera,
microphone), for which the recording should be found in the
archive

Drop-down list field for selecting the number of the device, for
which the recording should be found in the archive

Button for starting the search of recordings in the archive of the
chosen device. The recordings are searched in the entire archive
of the device. After the search is completed it is possible to
specify the approximate beginning ang end date and time for
required recording

The panel contains typical standard functions (from left to
right): backward, play, pause, stop, forward

The scale allows monitoring the playback progress and moving
between the frames. To move between the frames, drag the
slider or use the playback panel buttons in a per frame playback
mode.

The button for opening the Export Setup dialog box

The buttons for setting the first and the last frames of the
exported record

The button for hiding and showing the list of selected
recordings

The button for adding the selected recording (recording
segment) to the list

The button prints the current frame

The button exports the current frame in a specified format. A
dialog box opens for selecting the folder on the disk and
entering the file name.
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15 Export to AVl or archive
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Description

The button for starting the export of the recording (a recording

segment) in the specified format. A dialog opens for selecting
the device name, which made the recording. On export start, a
folder is created for saving the exported recordings (by default,
C:\Backup).

3.3.2 The Export Settings dialog box

To open the Export Settings dialog box, click the ﬂ button in the Archive's Converter window. The Export
Settings dialog box will open, allowing to specify export parameters.

il_;., Export Settings

|
=

— Choose Folder

Destination

Yolume Size, ME I 650

=
i+ AvI File
¥ Ereak Ta alarms

Frames per second IReaITime

£ mative archive
[~ Mative Formst

—Frame Exporkt
" Bitmap
+ Jpeg |

0 Cuality: 50 100

|
|

—Compressian

videa |Full Frames (Uncar & dio IF"CI"-“IJ 8,000 kHz;

~ Titles
Paint OF Sale I vI [ Mame, Date Time
% s UE W[ 100 H [ 100 Fart
~SCreen
v cwverlay ¥ keep Aspect Ratio

[+ Split A files

[ Always On Top

[T Digital sigristure

0k

N Parameter Field type Description
0 name
The Choose folder group

Form Defaultvalue Valuerange

at
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N Parameter Field type Description Form Defaultvalue Valuerange
0 name at

1 Destination Type-in the Type-in the folderonthe - - -
value disk to store the
exported files (by default
the Backup folder is
created on disk C:)

2  VolumeSize, Type-inthe Type-in the maximum MB 650 0to 2000 MB
MB value value of the volume (file)
size containing one or
more recordings.

If the size of recording for
export exceeds the set
one, then it will not be
split.

When the recording is
added to the volume, the
size of recording is
expected to equal the
mean value of sizes of all
added recordings. A new
recording is added to the
volume if it does not
exceed the volume size. A
real size of recording can
differ from the assumed
one, therefore the
volume size can exceed
the assumed one.

If the Break To Alarms
checkbox is checked,
each volume will contain
one recording only. The
field is disabled if the
Native Archive
parameter is activated.

3 Frames per Selectina Type-in the amount of fps RealTime 0.5; 1; 3; 5; 15; 30;
second drop-down grooming of the video RealTime
list recording
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N Parameter

0 hame
4 Native
Archive
AVI File
5 BreakTo
Alarms
6  Native
Format

Field type

Selecta
radio-button

Checkbox

Checkbox

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description
at

If the Native Archive - AVI File
radio-button is selected,

then archive fragments

will be exported keeping

the creation time, but

with no AVI conversion. If

the AVI File radio-button

is selected, then the

fragment is converted to

the AVI format using the

specified codec.

The checkbox is for - Unchecked
selecting the way of

storing the archive

export fragments to

volumes (files of

specified size): the

recordings for each

alarm will be saved to

separate volumes (files).

If the Native Format - Unchecked
checkbox is checked,
then video recordings are
exported to AVI file
without recompression,
i.e.in the same format as
in Axxon PSIM archive. To
playback these AViI files
on the computer without
Axxon PSIM software
package installed, install
components from Axxon
PSIM distributive
beforehand:

1. \Redist\VC2005_SP1\
vcredist_x86.exe

2. \Redist\CamMonitor\
CamMonitorlinstaller.
exe

Note. To playback AVI
files use Windows Media
Player.
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Form Default value

Value range

1. Native Archive
2. AVIFile

Unchecked - the
file (volume) will
contain a fragment
of the size specified
in the Volume Size,
MB field.

Checked - the
volume will contain
a fragment related
to one alarm only.

Unchecked - Axxon
PSIM archive is
exported to AVI file
with
recompression.

Checked - Axxon
PSIM archive is
exported to AVI file
without
recompression.



N Parameter Field type

o name

The Frame Export group

7  Bitmap Selecta
radio-button
Jpeg
8  Quality Set the slider

The Compression group

9 Video Click the
button
1 Field nextto Not to be
0 theVideo edited
button
1 Audio Click the
1 button

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description
at

If the Bitmap radio-
button is selected, then
the file is saved in Bitmap
format. If the Jpeg radio-
button is selected, then
the file is saved in Jpeg
format.

The parameter specifies % 80
the quality level of the

exported file. The value

of 100% results in no

quality loss.

The button is for -
selecting and setting up

the video codec used to
compress video

recordings. If the Native
Archive radio-button is
selected or the Native
Format checkbox is
checked, then this

button is disabled.

The field shows the info - Full Frame
on selected video codec. (Uncompr-
If the Native Archive essed),
radio-button is selected, Quality: 0

then this field is disabled.

The button is for - -
selecting and setting up

the quality of the

exported audio. The

Native Archive radio-

button is selected, then

this button is disabled.

Form Default value

Value range

0to 100

The list of codecs
found by the utility.
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N Parameter Field type

0 hame

1 Field nextto Not to be

2 theAudio edited
button

The Screen group

1  Overlay Checkbox

3

1  AlwaysOn Checkbox

4 Top

1 KeepAspect  Checkbox

5 Ratio

1 SplitAvifiles  Checkbox

6

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

The field shows the
selected audio format.

If the Overlay checkbox
is checked, there is
DirectDraw conversion

If the Always On Top
checkbox is checked,
then Converter window
is always over all other
windows

If the Keep Aspect Ratio

checkbox is checked, the

aspect ratio of Converter
window is fixed.

Activates export of
selected video
recordings to the
separate AVl files.

Note. If the checkbox is
not checked, video
recordings from one
camera are exported to
one AVl file.

Form
at

Default value

PCM, 8000
kHz; 16 bit;
Mono

Checked

Unchecked

Unchecked

Checked

Value range

The list of quality
levels detected.

Checked - use
DirectDraw for
conversion

Unchecked - do not
use DirectDraw for
conversion

Checked - the
window is
displayed on top.

Unchecked - the
window is not
displayed on top.

Checked - 3:2 ratio
is kept when the
size of the dialog
box is changed.

Unchecked - 3:2
ratio is not kept
when the size of the
dialog box is
changed.

Checked - video
recordings are
exported to the
separate AVl files.

Unchecked - video
recordings are
exported to one AVI
file.
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N Parameter
0 hame

1 Digital
7  signature

Field type

Checkbox

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Activates adding digital
signature that is used for
checking frame
authenticity to exported
frames.

Note. Checking frame
authenticity is performed
using SignCheck.exe
utility (see The
SignCheck.exe utility for
checking the authenticity
of exported frames and
video recordings section)

Form Default value

at

Unchecked

Value range

Checked - digital
signature is added.

Unchecked - digital
signature is not
added.

If a microphone was selected as a device in the dialog box of Converter.exe utility, only the Audio button and the
Screen group are enabled.

3.3.3 Adialog box for choosing the video codec

The Video button in the Export Setup dialog box opens a dialog box for choosing a video codec to be used for video

compression.

Choose Destination Yideo Forma

Compresz:sar;

o ]|

x|

IMiu:ru:usu:uft Yideo 1

Comprezsion Clualiby:

o N

j Canizel |

22 _I Configure... |
L3
About.. |

N Parameter
0 hame

1 Compressio
n program

Field type

Select from
drop-down
list

Description

The button allows
selecting and setting
up the video codec
used to convert and
compress the video
image.

Format

Codec
name

Default value

Full frames
(no compre-
ssion)

Value range

Allvideo codecs
recognized by the
operating system
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N Parameter Field type Description Format Default value Value range
0 name
2 Compressio  Dragthe The slider allows % 0 0to 100

n quality slider setting the

compression level. The
zero position of the
slider represents the
highest compression
and lowest quality.
Changing this
parameter is enabled if
the codec is selected in
the Compression
Program field.

3  Setup.. Click the The button opens the - - -
button settings panel of the
video codec. Seethe
codec manual for

details.
4 About Click the The button opens an - - -
button information box with

codec details.

() Note.

If AVI format is used, the resultant file size should not exceed 2 GB.

3.3.4 Adialog box for choosing the audio format
The Sound button in the Export Setup dialog box opens a dialog box for choosing an audio format.

Choose Destination Audio Format x|

I amne:

[untitled] - Save bz, | Hemoyve |

Faormat; I PCH j

Altributes: |B,nnn kHz: 16 Bit: Mano 15kbisec =]

k. I Cancel
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Parameter
name

Name

Format

Attributes

Save as...

Field type

Select from
drop-down list

Select from
drop-down list

Select from
drop-down list

Click the
button

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

The field allows
choosing the name
for the selected audio
format.

The field for selecting
the format

The list of sound
characteristics:
playback/recording
frequency (8000 kHz),
digitizing level (8, 16,
etc bits), channel type
(mono/stereo)

The button allows
creating a unique
name for the selected
format. To save a
format under a
unique name:

1. Select Untitled in
the Name field.

2. Select the values in
the Format and
Attributes fields.

3. Click the Save As
button

4. Enter a unique
name in the Save
This Format As field
and click OK.

The newly created
name will appearin
the Name drop-down
list.

Format

Format
name

Format
name

Parame-ter
values

String

Default
value

Untitled

PCM

PCM, 8000
kHz, Mono

Value range

Untitiled

CD Quality

Radio Quality
Telephone Quality
Compact disk

The list of audio
formats used by
the utility.

The list of
characteristics,
recognized by the
operating system
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3.4 Usingthe Converter.exe utility

3.4.1 General description of the Converter.exe utility

The Converter.exe utility is designed to convert and play back audio and video recordings from the archive and save
them to a specified folder.

Using the Converter.exe utility includes:

1.

NG WN

Starting the utility (see Starting and shutting-down the Converter.exe utility).

Selecting an archive (see Selecting an archive to be played or converted).

Finding a recording in the selected archive (see Selecting an archive to be played or converted).
Playback of the recording (see Recording playback).

Finding the required recording fragment or frame (see Searching for a video recording).

Setting the export or conversion parameters (see Converting video and audio archives to AVI files).
Exporting the fragment or printing the frame (see Exporting recordings and frames).
Shutting-down the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).

3.4.2 Selecting an archive to be played or converted

To search an archive for a recording, do the following:

1.
2.

Select the device the recording was made by, and its number (1).
Click the Search button (2).

&% Archive's converter ] = | | |£I
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3. Select the location of the archive (folder with archives for specific date and time) on an appropriate disk.

Parse Drives;Folder A
Password | A

] \%3'5 Floppy (&)
" g Local Disk (1)
)

£ v (D
[ <& ,D'-.-'D R&M Drive (D0

| =l
B

o Y

4, Click the L button.

5. Specify the time limits in the date/time fields (3).

The first frame of the required recording will be displayed in the video playback screen.

() Note.

In case of searching for an audio recording, no visible signs of finding the recording will be shown. To
check that a recording was found, play it.

() Note.

Speed of records search directly depends on their number. The search process can take a lot of time if the
archive depth is rather big and reading is performing from the network disk.

() Note.

If video files that are to be opened were not recorded, but copied, then start the Convert.exe utility to open
the archive (see The Convert.exe utility for correcting modification dates of video archives section):
« Ifthe archive is created in the same time zone as it is viewed, then start the utility with the fullmode
parameter:
convert.exe fullmode

« Ifthe archive is created in different time zone than it is viewed, then move the archive to the
current time zone by starting the utility with the following parameters in the command prompt:
convert.exe fullmode TZ +hh:mm
where +hh:mm is the time shift between the current time zone and the time zone of the archive.

Otherwise, the folders with video files fail to open.

3.4.3 Searching for a video recording

After the approximate time interval is selected using the date/time fields, and the required archive is found, it may
be necessary to find a particular fragment or frame to be played or exported.
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Searching for a fragmentin a recording

To find the required video fragment in the selected recording, do the following:

1. Click the Play (ﬂ) button in the playback control panel.

N

When the required fragment appears, click the Pause (ﬂ) button.
Click the Fragment Start (ﬂ) button to make the current frame the start of the fragment.
Click the Play (ﬂ) button in the playback control panel.

> W

5. When the required fragment ends, click the Fragment End (ﬂ) button to make the current frame the end
of the fragment. All subsequent frames will be omitted.

The resultant recording fragment will then be available for conversion or export, maintaining the format and the
creation date.

Searching for a frame in a recording

To find a particular frame in the selected recording, do the following:

1. Click the Play (ﬂ) button in the playback control panel.
2. When the required frame appears, click the Pause (M) button to enter the per frame playback mode.

() Note.
If the recording is to be played back in the per frame playback mode starting with the first frame,

then click the Pause (M) button instead of the Play (ﬂ) button.

3. Keep clicking the Fragment Forward (M) and Fragment Back (ﬂ) buttons, to browse the frames
until the required frame appears on the screen.

The resultant frame may be printed or used as a starting frame for a fragment (see Searching for a fragmentin a
recording section).

() Note.

To quit the per frame playback mode, click the Pause (ﬂ) button once more.

3.4.4 Recording playback

The recording selected by date and time, can be played in Converter.exe player using the playback control panel.
D nmH

The panel contains five control buttons (left to right on the figure): Back, Play, Pause, Stop, Forward, allowing to
play, pause, stop and browse the records.

1. If the Stop button is down (clicked), then it is possible to move between the recording segments by clicking
the Forward or Back buttons. The recording segment means one of the following:
+ asegment of video recording between the commands to start and stop recording if the recording was
initiated manually (for example, via a script or the camera's context menu);
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+ asegment of video recording between the beginning and the end of the detection tool triggering,
taking into account the periods of pre- and post-recording in case the recording was initiated by any
detection tool.

2. Ashort press of the Play button starts playing the recording segment from start to end. If the recording
contains several recording segments, the Play button should be clicked to play each of them.
3. To play a record consisting of several segments without stopping, press and hold the Play button for 1-2

seconds. The button then changes its appearance from ﬁ to 4 . To stop playback, click Stop.

4. To play the recording in the frame-by-frame mode: a) click Play, b) click Pause, c) keep clicking Forward or
Back to view frames one by one.

5. Toview the recording segment in accelerated mode click the Play button and then click the Forward to
accelerate twice relatively the previous speed. The current playback speed is displayed in titles above video
image.

6. To view the record section in slow motion, click the Play button and then click the Back to slow down twice
relatively the previous speed. The current playback speed is displayed in titles above video image.

3.4.5 Converting video and audio archives to AVI files

Video and audio archives are converted into AVI format according to Converter.exe settings, using the Export Setup
dialog box. The level of compression of the exported recording is determined by the following parameters:

1. Frames Per Second parameter - setting the parameters of the recording grooming;
2. Video button - selection of the video codec, in case of video archive export;
3. Sound button - set the sound quality parameters (frequency, bitrate, etc), in case of audio archive export.

() Note.

If AVI format is used, the resultant file size should not exceed 2 GB.

3.4.6 Exporting recordings and frames

Export of the recordings is one of the main functions of the Converter.exe utility. There are two ways of exporting
records from an archive:

1. Export to AVI option converts (compresses) a recording and breaks it down into volumes (files of the size
specified in the Export Setup dialog box).
To export the recording as AVI, do the following:
a. Find therecordingin an archive (see the Selecting an archive to be played or converted section).
b. Inthe Export Setup dialog box, select the Export to AVI radio-button.
c. Click the Video or Sound button to specify the conversion parameters. Click the OK button.

d. Click the Exportto AVI/Archive button (IE') to start exporting.
e. Enter the name of the device folder to save the recording to (1), then click Continue ( 2).

B A

Enter Camera Mame

2 Contie__J

The export progress will be shown in the title bar of the Converter.exe window.
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E% 08-08 -09 14:35:5 « (6% Done..)

A=) | =
Eha.naznngjhm&asﬁ T Jrsos.zo0s ] [14is1:07 jE
[Grem [T 18 « »|1n|m|»| &

The title bar will read Complete, when exporting is completed. To verify the results, open the Backup
folder and find the file named after the device from which archive the recording was exported.
2. The Export to Archive option allows copying the files from an archive to another location on the disk with no
conversion, maintaining the recording creation date and an option for breaking it down into volumes.
To export a recording in the same format as it is stored in the archive, do the following:
a. Find the recording in the archive (see the Selecting an archive to be played or converted section).
b. Inthe Export Setup dialog box, select the Export to Archive radio-button.
c. Specify volume size in the Export Setup dialog box. Click the OK button.

d. Click the Export to AVI/Archive button (IE') to start exporting.

(@ Note.

If AVI format is used, the resultant file size should not exceed 2 GB.

The Converter.exe utility allows exporting frames into bitmap and JPEG formats. Do the following:

1. a. Find the required frame (see the Searching for a frame in a recording section).
b. Inthe Export Setup dialog box, specify the parameter values in the Frame Export group. Click the

OK button.
c. Click the Export Frame button (@).
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d. Specify the location to save the exported file to in the Save As dialog window.
Save i IB My Documents j & * 2 -

\_ My eBooks

@ Ty PMusic

T E‘My Pictures
Dacumer \_)5naglt Cakalog

m} 7= visual Studio 2005

Desktop

1 2 3
(am 8-05-09C14'35'3 .jpg_D

File name: ((Cam 1 [D5-05-09 14'3533) j Save I
Save a3 type: I.Jpeg Files [*.jpa;” jpeal j Cancel |

The file name will be generated automatically in the following format: 1) name and number of the
camera where the frame comes from; 2) creation date; 3) creation time. The file extension
corresponds to the file format selected in the Export Setup dialog box.

e. Click the Save button.

3.4.7 Usinga command prompt to work with the Converter.exe utility
Video and frames can be exported with the help of a command prompt using the following commands:
Converter.exe Disc:\File,Number_Cam,StartDate StartTime,StopDate StopTime,CameraName

Converter.exe Disc:\File,Number_Cam,StartDate StartTime,,CameraName

() Note.

If StopDate and StopTime parameters are not specified, then ‘,” is to be specified instead.

The table describes the command parameters.

Parameter Description
Disk Disk for storing exported files
File Name of a catalogue or file.

Note 1. If the catalogue or file specified in the command does not exist, it will
be created automatically.

Note 2. To export archive (video record in the original format) only catalogue
name is to be specified.
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Number_Cam Number of a camera which performs the recording
StartDate Date of record start (dd-mm-yy)
StartTime Time of record start (hh:mm:ss)
StopDate Date of record end (dd-mm-yy).

Note. Parameter is not in use while exporting the separate frames

StopTime Time of record end (hh:mm:ss)

Note. Parameter is not in use while exporting the separate frames

CameraName Name of the camera that is to be displayed in the titles on the exported
video, as well as the name of the folder created in the specified export folder
used for storing exported files.

The example of using the command prompt to export files is shown in the figure.

ommand Prompt
Microsoft Windows HP [Uersion 5.1.26881]
(C> Copyright 1985-2081 Microsoft Corp.

C:x“Program Filez“HuHTeasekTToolz>Converter.exe E:“\Export.1,26-01-15 11:10:30,.26
01-15 11:35:07.Camera 1

“Program Filezs“Huteasext \Tools>Converter.exe E:“\Exportiexport.avi.l. 26-01-15
110:30,26-01-15 11:35:07,Camera 1

:SProgram Files“Huteaaekt \Tools>Converter.exe E:“\Exporthexport.jpg.l.26-01-15
110:30,.26-01-15 11:35:07,.Camera 1

:“Program FilezsIntellect~Tools>_

As aresult the “export” folder containing the exported files is created on the local disk “E”.
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Foders  [T17]-
Mame - Size
l._jDISKl
() export 20953 ...
@ export 14KB

[

v @

Type Date Modified
File Folder 18.10.20...
“fideno File 12.10.20,..
JPEG Image 13.10.20,..

3.4.8 Printing a frame

To print a frame, do the following:

1. Find the required frame (see the Searching for a frame in a recording section).

2. Click the Print Frame button (@).

3. Astandard dialog box for printing and printer setup will be opened.

3.4.9 Exporting video with titles

Video with titles is exported as follows:

1. Run the Converter.exe utility(see Starting and shutting-down the Converter.exe utility).
2. Call for Export Settings dialog window in the opened window of Converter.exe utility and set its groups
Choose folder, Frame Export, Compression and Screen (see. Interface description of The Export Settings

dialog box).
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3. Setthetitles displaying in the Titles group in the dialog window Export Settings; table shows parameters

description of the given.

."i,‘.:»a Export Settings

Choose Folder

Destination

Yolume Size, MB |65tl

Frames per second IReaITimE

" Mative Archive

' AVIFile
¥ Break To alarms

k2

i Frame Export
" Bitmap

Cualiby: 80 100

% Jpeqg |

1
_

Compression

videa |FUll Frames (Uncar — Aydin |F'(Zr'-'1J 8,000 kHz;

\

3 c Mame, Date TimD 2

4
I i Y e )

e
Screen

V¥ Overlay
I always on Top

v keep Aspect Ratio

k.

Ne Parameter name

1 Point of sale
dropdown list

2 Checkbox Name,
Date, Time

Parameter description

Name of cash terminal, titles from
which should be laid over the video
recording while viewing and
exporting the frames and recordings
with the help of Converter.exe
utility.

When the given checkbox is
activated , lines, containing name
and number of a camera, date and
time of creation of the given video
frame , will be laid over the video
recording.

Value range

Empty value- titles from all the
titrates overlay function .

no - overlay function is off.
Number of cash terminal (from
one and above) - function of
displaying the titles concerning
the given cash terminal.

Yes - lines, containing name and
number of a camera, date and
time of creation of the given video
frame , will be laid over the video
recording.

No - lines, containing name and
number of a camera, date and
time of creation of the given video
frame, will not be laid over the
video recording.
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3 Editing text fields X,Y, Coordinates and area size ,taken by  From 0 and above.

W, H titles in the video recording. Is Depends on the screen size of
expressed in percentage relative to video recording playback.
the screen size of video recording
playback.

4 Font button Font selection of titles displaying.

(@ Note.
If the cash terminal is selected, its value will not be saved with the repeated run of Converter.exe

utility. On default displaying titles from all the titers is set.

4. To apply the settings it is necessary to click OK button. To cancel settings one should click the cross mark in
the upper right corner of Export Settings dialog window.

5. Dialog window of Converter.exe utility for exporting the required file will open in result (see. Exporting
recordings and frames).

Export of video recordings with titles is completed.
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4 Tweaki.exe utility for advanced setup of the Axxon PSIM
software system

4.1 The purpose of tweaki.exe utility

The tweaki.exe utility is designed for configuring the Axxon PSIM system by editing the sections of the Windows
registry, where the setup parameters for the Axxon PSIM core and modules are stored:

« For 64-bit systems, the sections are HKLM\SOFTWARE\Wow6432Node\AxxonSoft and

HKCU\SOFTWARE\Wow6432Node\AxxonSoft.

« For 32-bit systems, the sections are HKLM\SOFTWARE\AxxonSoft and HKCU\SOFTWARE\AxxonSoft.

() Attention!

Specifying invalid values of the registry keys may lead to system failure.

The Tweaki.exe utility provides the following functionality:

1.

aorwN

o

10.
11.
12.
13.
14,
15.

Setup of Axxon PSIM system start-up (see The Settings panel of the Windows section);

Enabling the debug mode (see Selecting and enabling the debug mode of Axxon PSIM software);

Advanced setup of the video surveillance monitor (see The Settings panel of the Video subsystem section);
Advanced setup of events logging (see The Settings panel of the Axxon PSIM section);

Advanced setup of video signal processing by Server (see The Settings panel of the Video subsystem
section);

Advanced setup of distributed architecture (see Extended setup of the distributed architecture);

Changing netnames and IP-addresses in the configuration database (see Changing computer names and IP
addresses in the Axxon PSIM configuration database);

Limiting the RAM used by MS SQL server (see Limiting memory usage by an MS SQL server);

. Advanced setup of audio or video recording to an archive (see The Settings panel of the Video subsystem

section);

Re-indexing audio and video archives (see Re-indexing the audio and video recordings archive);
Selecting the analog video out operation mode The Settings panel of the Video subsystem section);
Testing the operability of video capture cards (see Testing video capture cards);

Advanced setup of PTZ devices (see The Settings panel of the PTZ section);

Advanced setup of POS-Axxon PSIM (see The Settings panel of the POS PSIM section);

Displaying versions of Axxon PSIM modules (see The Settings panel of the Version section).

4.2 Starting and shutting-down the Tweaki.exe utility

To start the tweaki.exe utility, do one of the following:

1.

2.

Start the utility from the Windows taskbar. Click Start => All Programs => Axxon PSIM => Tools =>
Advanced settings utility. The tweaki.exe utility is available from the Start menu with the following
installation types of Axxon PSIM: Server, Remote administrator workstation, Remote client.

Start the utility from the Tools folder of the Axxon PSIM program folder: C:\Axxon PSIM\Tools\Tweaki.exe.

The Axxon PSIM Advanced Setup dialog box appears after running the tweaki.exe utility.
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PRl Windows
B[ Axon PSIM
[> DNS Shell
i[> isitor management system
- [» Distributed corfiguration ® Explorer
i[> MSDE (M5 SQL) corfiguration ) File
- [» Video subsystem
.. [» Testing video capture cards
> PTZ
[> POS
o[> Veersion Enable
Usemame
[comMPUTER

Password
|

Autologon

Domain

Awxon PSIM start serviee
Restart Axxon PSIM on user login
To resfar, the user must belpng fo PSIM Users

% Axxon PSIME Advanced Setup

To shutdown the tweaki.exe utility and save the changes click OK. To shutdown the tweaki.exe utility without
saving the changes, click [2].

4.3 Interface of the Tweaki.exe utility

The user interface of the tweaki.exe utility consists of two interrelated elements:

1. Tree of sections (1).
2. Settings panel for each section (2).
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oI indows

B on

: Shel
[> Visitor management system
[» Distributed configuration ® Explorer

i [» MSDE (M5 SQL) corfiguration ) File

- [> Video subsystem

- [ Testing video capture cards

[ PTZ

- [> POS Autologon

.. [> Version _) Enable

Usemame
|comPUTER

Pazswond
|

Domain

HAxxon PSIM start service
Restart Axxon PSIM on user login
To resiart, the user must belong fo PSIM Lisers

SX Axxon PSIME Advanced Setup

Sections tree of the tweaki.exe dialog box has static structure and is used for navigation in the utility. To access the
settings panel for the required section, left-click the corresponding tree tab.

4.3.1 The Settings panel of the Windows section

The Windows section is used to set Windows running Windows OS. The settings panel for the Windows section is
shown in the figure.
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The parameters of the Windows setting panel are described in the table.

N Parameter Field type

0 name

The Shell group

1 TheExplorer/ Setinthe
File switch position

" L

- [> DNS
[> Visitor management system
[» Distributed configuration
- [> MSDE (MS SGL) corfiguration
- [> Video subsystem
- [ Testing video capture cards
D P2
.- [> POS

- [ Version
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Windews

Shel
(®) Explorer
) File

Autologon
Enable 3

Usemame

|comPUTER

Pazswond

Domain

HAxxon PSIM start service
Restart fooon PSIM on userlogin
To resiart, the user must belong fo PSIM Lisers

Description

Selection of Windows -
working shell

Attention! Disable UAC
to run the Axxon PSIM
software package as
the shell. Configuration
of the local security
policy is required for
full disabling of UAC in
the Windows 8 and
Windows 8.1 OS - see
OS settings for correct
operation of Remote
Admin Workstation or
Server

Represen
tation

Default
value

Explorer

Value range

Explorer - Microsoft
Explorer is loaded as
working Windows OS
shell (corresponds to
standard Windows
OS settings).

File - Axxon PSIM
starts as a working
shell of Windows OS
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N Parameter Field type

0 hame

2 ThefFilefield Button is
with = pressed
button. Active
for the File
switch
position

The Autologon group

3 TheEnable Checkbox
checkbox

4 The Type-in the
Username value
field

5 ThePassword Type-inthe
field value

6 The Domain Automatical
field ly
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Description Represen

Opens standard - -
Windows window

«Open» to select shell

file of OS Windows.

Full path to thefile is

displayed in the field.

Activates automatic Boolean No
log on of the user to type
0OS Windows

Set the username for - -
logging on the OS
Windows

Set the password for - -
logging on the OS
Windows

Displays the name of - -
domain server (if there

is any), where data

concerning user

account is stored (user

name and password)

Default
tation value

Value range

The psim.exe or
psim_host.exe
executive file is
selected as a shell

Yes - automatic log
on of the user is
activated

No - automatic log
on of the user is not
activated

Up to 64 characters.
Depends on the
settings of Windows
user account (stored
locally or on domain
server)

8 to 14 characters

Depends on the
settings of Window’s
user account (stored
locally or on domain
server)

Depends on domain
net settings (net
settings of OS
Windows
correspondingly)
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0 hame

7 Restart
Axxon PSIM
on user login
checkbox

Field type

Setting
checkbox

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Specifies the way of
restart the Axxon PSIM
software installed as a
service on user login

Represen
tation

Boolean
type

4.3.2 The Settings panel of the Axxon PSIM section

The Axxon PSIM section is used for Axxon PSIM advanced setup. The settings panel for the Axxon PSIM section is

shown in the figure.

Default
value

Yes

Value range

Yes - the Axxon PSIM
software installed as
a service restarts
under the current
user if it belongs to
the Axxon PSIM Users
group.

No - The Axxon PSIM
software installed as
a service doesn't
restart under the
current user even for
users belonging to
the Axxon PSIM Users

group.
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Core P address 1

127.0.0.1

Logging subsystem
Debug mode
Disabled V 3
Time of log keeping (hours):

48 4
Counters logging period (s):

[60 |5
Path for export of JPG and AV files
(® Default (fwxon PSIM\Export) ©

0 other] Q)

[] Receive uncompressed video'l 3
[ Evert protocol over all windows] 4
] Only local protocal 15

[] Sort tree objects by ID1 6
Overay in event protocol

| None

v|21

% Axxon PSIME Advanced Setup

The parameters of the Axxon PSIM settings panel are described in the table.

N Parameter Field type
0 name
1 TheCorelP Type-in the
address value in the
field with field/use the
= L < | button

button. Is set
on the Client

Description Representa
tion
Set the IP address IP address

of the Axxon PSIM
server to which the
psim_host.exe
module is
connected by
default.

In case of pressing

L= | button, IP
address of the local
computer is set.

Keyboard prefix 2

il |

Keep logs B
[] Forward to debugger?

Maximum size (MB):

[100 8

[] Record path ] 2
(= Open folder ] 4

[] Disable protocol1 T

[ Used memory dump1 8
Old scripts support 4 Q)
[1 Time synchronization 20
Application language
Englsh (United States)

Default Value range
value
127.0.0.1 Depends on net

settings of the
Server. In case of
connection failure
dialog window
requiring IP address
is displayed
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N Parameter Field type Description Representa Default Value range

0 hame tion value

2 The Type-in the Set the prefix for a Symbol - Usually, a tilde (~),
Keyboard value in the special key-board. code 126
prefix field field When a button is

pressed on this
key-board the
Axxon PSIM detects
when the button
was pressed on this
very key-board

The Logging subsystem group
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N Parameter Field type Description Representa Default Value range
0 hame tion value

3 TheDebug Drop-down Set the mode of the  List of None Disabled - Debug
mode list item Axxon PSIM Debug available window is not
dropdown window displaying = modes of displayed.
list Debug

window
displaying

Debug 1 - Debug
window is
displayed and a
log-file containing
recordings about
modules errors is
created.

Debug 2 - Debug
window is
displayed and a log-
file containing
recordings about
modules errors and
alerts is created.

Debug 3 - Debug
window is
displayed and a log-
file containing
recordings about all
the modules events
is created.

Debug 4 - Debug
window is
displayed and a log-
file containing
recordings about all
the modules events,
and also additional
menu that is
individual for each
module (used by
programmers) are
created.

4  Thelog- Type-in the Set the time of Sequence 48 hours >0
storing time  valuein the keeping log files
(hours) field field
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Parameter
name

The
Counters
logging
time (sec)
field

The Save
logs
checkbox

The
Redirect to
debugger
checkbox

The
Maximum
size (MB)
field

Field type

Type-in the
valuein the
field

Checkbox

Checkbox

Type-in the
value in the
field
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Description

Assigns the time
interval in seconds
for logging
processor load,
memory usage,
and disk usage.

Enables logs saving

Enables the
debugger

Defines the
maximum size of
RAM that log files
can use. Log files
are archived after
that size is
reached.

The JPG and AVI files export path group

9

The Default

(Axxon
PSIM\Exp-
ort)/Other
switch

Setin the
position

Set the folder for
exported files from
Axxon PSIM video
archive

Representa
tion

Sequence

Boolean
type

Boolean
type

Sequence

Default
value

60

Yes

None

100 MB

Default
(Axxon
PSIM\Expor
t)

Value range

Positive whole
numbers not less
than 60 and zero. If
thevalueOis
specified, sensor
datais notincluded
in the log file.

Yes - logs are
saved.

No - logs are not
saved.

Yes -the debugger
isin use.

No - the debugger
isnotin use.

>=100

Values less than 100
Mb are ignored.

Default (Axxon
PSIM\Export) -
exported to the C:
\Users\%current
user name%
\Documents\Axxon
PSIM\export\ folder

Other - exported to
the selected folder
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0 hame

1 The Other

0 field with
the &
button

1 TheOpen

1 folder
button

1 TheRecord

2 path
checkbox
No group

1  The Receive
3 uncompress
ed video
checkbox

[y

The Event

4 viewer over
all windows
checkbox

Field type

Click the
button/type-
inthevaluein
the field

Click the
button

Checkbox

Checkbox

Checkbox
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Description Representa

Set the pathname Pathname -
to the folder, where

files from video

archive are to be

exported when the

switch is setin the

Other position

Opens the current - -
folder to export
the files

The checkbox Boolean No
forbids export type

catalogue change

while exporting the

archive period as

well as exporting

the archive from

AviExport utility.

Enables receiving Boolean No
uncompressed type

video from the

Server.Asaruleis

set on the Client

Enable displaying Boolean No
the Event viewer type

window over all

windows.

Default
tion value

Value range

Yes - export
catalogue change is
forbidden.

No - export
catalogue change is
allowed.

Yes - Client receives
uncompressed
video from the
Server

No - Client receives
compressed video
from the Server

Yes - the Event
viewer window is
displayed over all
windows.

No - the Event
viewer window is
displayedifa
corresponding
screen is selected
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Parameter
name

Field type

The Only Checkbox
local
protocol

checkbox

The Sort Checkbox
tree objects
by ID

checkbox
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Description

Enables logging the
events registered in
the given computer
to the Events

protocol database.

Note. This
parameter can be
set on the settings
panel of the
Computer object -
see Configuring
events logging
section.

Enables sorting of
objects in the tree
by identifier.

Note 1. If sorting by
name is chosen,
and there are
numbers in the
object name, then
the objects will be
sorted in
alphabetical order.
Forexample, an
object with the
name "115" will be
above the object
with the name "15",
because in the
name "115" the
second numberis 1,
and in the name
"15" the second
number is 5.

Note 2. This key
also affects the
sorting of objects in
the tree when
adding the objects
toalayerin the
Map Editor utility.

Representa
tion

Boolean
type

Boolean
type

Default
value

No

No

Value range

Yes - events
registered in the
given computer are
recorded to the
Events protocol
database

No - all required
events are recorded
to the Events
protocol database

Yes - objects in the
tree are sorted by
identifier

No - objects in the
tree are sorted by
name

Tweaki.exe utility for advanced setup of the Axxon PSIM software system- 46


https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging

Parameter
name

Field type

The Disable Checkbox
protocol
checkbox

The Used Checkbox
memory

dump

checkbox

The Support  Checkbox
old scripts
checkbox
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Description

Disables events Boolean No
logging to the type

Event viewer

database on this

computer.

Note. This
parameter can be
set on the settings
panel of the
Computer object -
see Configuring
events logging
section.

Enables Boolean No
logging .dmp file type

with a copy of main

memory with

incorrect shutting

down at least one

of the system

modules to the

Axxon PSIM root

folder

Set the support of Boolean No
program tools in type

Axxon PSIM

Representa Default
tion value

Value range

Yes - events are not
logged to the Event
viewer database

No - events are
logged to the Event
viewer database

Yes - memory
dump is created

No - memory dump
is not created

Yes - both scripts
and programs are
supported

No - only scripts are
supported
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N Parameter

0 name

2 TheTime

0 synchroniza
tion
checkbox

2 The Overlay

1 inEvent
protocol
dropdown
list

2 The

2  Application
language
dropdown
list

Field type

Checkbox

Drop-down
listitem

Drop-down
listitem
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Description

Settime
synchronization of
all computersin
the distributed
system with system
time of this
computer. Time is
automatically
synchronized at
midnight every 24
hours or when
Axxon PSIM is
started on the
Server that is the
source of time
synchronization.

Set the overlay
mode for
processing the
video signals that
can be viewed with
the help of the
Event protocol
object

Assigns the Axxon
PSIM Software
System's interface
language

The Settings panel of the DNS section

Representa Default
tion value

Boolean No
type

Names of
overlay
modes

Overlay 2

Names of -
installed
languages

Value range

Yes -
synchronization is
enabled

No -
synchronization is
disabled

None - video
signals are not
processed by video
card

Overlay 1 -
Direct3D is used

Overlay 2 -
DirectDraw is used

Depends on the set
of installed
languages.

The DNS section is used for setting the automatic connection between the Client and reserve Servers in case of
connection loss with the main Server. In the DNS section it is necessary to specify netnames and IP-addresses of
reserve Servers as they are not listed in the Windows registry by default.

The settings panel for the DNS section is shown in the figure.
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Windows

System identifier IP address

- =t anagement system
i[> Distributed configuration
t-[> MSDE (MS SQL) configuration
Video subsystem
Testing video capture cards
PTZ
POS
Version

3

Mlow all names

% Axxon PSIME Advanced Setup

The parameters of the DNS settings panel are described in the table.

Ne Parameter  Field type Description Represent  Default Value range
name ation value
1 The System  Type-in the Set the netname of - - Depends on net
identifier value in the the reserve video settings of
column field Server if the reserve video
connection with server

main Server is lost

2 The IP- Type-in the Set the IP-address of ~ IP-address - Depends on net
address value in the the selected reserve settings of
column field. video Server reserve video

Server
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Ne Parameter  Field type Description Represent Default Value range
name ation value
3 The Allow Click the Computer’s IP- - - -
all names button addresses, set in the
button System identifier
column, are

automatically added
to the IP-address
column, if these
addresses are
enabled and
identified

The Settings panel of the Visitor management system section

The Visitor management system section is designed for creating common photo database of the Access
Manager module (is not included into Axxon PSIM base configuration). In this section it is necessary to specify

netnames of computer where the photos are to be stored. Photos are to be stored in the Person folder (<Axxon
PSIM>\Bmp\Person).

() Note.

The Person folder is automatically created when the Access Manager module is installed.

Windows

Axon PSIM
e [puLS

VMisitor management syst

. System identifier
Visitor management system

i[> MSDE (MS SQL) configuration
Video subsystem
Testing video capture cards
PTZ
POS

Version

% Axxon PSIME Advanced Setup
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The Settings panel of the Distributed configuration section

The Distributed configuration section is for Axxon PSIM common database adjustment when real computer
netnames do not coincide with the names in the database (for instance when the computer with the database is
replaced). The section is also used for adjusting IP-address of selected computer in the database.

The settings panel for the Distributed configuration section is shown in the figure.

e [ Windows

: Distributed eonf
5[ Ao PSIM Distributed confi

Select database 1 | Use cumrent DB 2

; { ¢ Available systems:

e A

- [» Video subsystem ! System identifier
- [ Testing video capture cards
. [» POS

- [3 Version

New system 1D
[LocALHOST

[ Update protocal 5
[] Clear protacol G 7

Update DB

8

Change IP address Q) 10

<] > 127001 [

% Axxon PSIME Advanced Setup

The parameters of the settings panel are described in the table.

Ne Parameter Field type Description Representatio Default Valuerange
name n value

1 The Select Click the button ~ Opensthe - - -

database standard Data

button Link Properties
dialog box to
choose the

database, where
netname and/or
IP-address are to
be changed.
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Ne Parameter Field type Description Representatio Default Valuerange
name n value
2 The Use Click the button  Selection of
current DB main Axxon PSIM
button database
3 The Automatically Displays the list - - Netnames of
Available of netnames of computers
systems computers that connections
table arein selected between which are
database seton the
Architecture tab
4 The New Buttonisclicked Specifies a new - - Depends on the
system ID andvalue is netname of a current net
field with selected from computer settings of the
< | putton  thelist/typedin  selectedinthe required
the field. Available computer.

systems table If the network

name is longer
than 15
characters, then
first 15 characters
are to be specified
as the network
name in this field

5 The Update Checkbox Replaces the Boolean type None Yes - computer’s
protocol computer’s netname is
checkbox netname in the replaced in the

Events protocol Events protocol
table of the table
selected main

No - computer’s
netname is not
replaced in the
Events protocol
table

Axxon PSIM
database
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Parameter
name

Field type

The Clear Checkbox
protocol

checkbox

The Update Click the button

DB button

The Update
protocol
field

Automatically

The Change IP address group

10

The Select from the
dropdown list

list with IP-

addresses

Field of Type-in the
setting IP- value in the field
address
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Description

Clears the event
log from the
Events protocol
table of the
selected main
Axxon PSIM
database

Runs the
process of
updating the
selected
database in
accordance with
given settings

Displays
updating process
of the selected
database

Specifies IP-
address thatis to
be changed in
the selected
database

Specifies a new
IP-address to be
changed in the
selected
database

Representatio  Default
n value
Boolean type None
IP-addresses of -
computersin

the selected

database

IP-address 127.0.0.1

Value range

No - the list of
registered events
is not cleared

Checked - the list
of registered
events is cleared

Depends on the
structure of the
selected database
and the given
settings

Depends on the
number of
computers
connections
between which are
set on the
Architecture tab

Depends on the
current net
settings of the
required computer
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Ne Parameter Field type Description Representatio Default Valuerange
name n value
11  TheEdit Click the button ~ Changes the IP- - - -
button address of the
required
computerinthe
selected
database

The Settings panel of the MSDE (MS SQL) configuration section

The MSDE (MS SQL) configuration section is designed for setting the limits of RAM space for MS SQL Server
operation with databases of SQL format. This limitation enhances the performance of the system.

The settings panel for the MSDE (MS SQL) configuration section is shown in the figure.

[ Windows MENE [(ME &0 et
L——_|[> Aocxon PSIM F_ | i) B )= [r_rlu i J[—_)I COn

b [> DNS
i[> Visitor management system

Sele.ct d.atabase

= Maximum memory usage (MB)
L) corfiguration 2095

. [> PTZ S0 database size: GB

.. [> POS
.. [» Version 4

% Axxon PSIME Advanced Setup

The parameters of the settings panel are described in the table.
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Ne Parameter
name

1 The Select
database
button

2 The Use
current DB
button

3 The
Maximum
memory
usage (MB)
indicator

4 The SQL
database
size field

Field type

Click the
button

Click the
button

Enter the
valuein the
field

Automaticall
y

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description Representation Default Value range
value

Opens the standard - - .

Data Link

Properties dialog
box for choosing
the database of MS
SQL format the
RAM space for
which is to be
limited.

Selects the main - - R

Axxon PSIM

database

Sets the space of MB 4096 Depends on full
RAM in MB for SQL space of RAM.

Server operation

Displays the Positive real - Depends on the

current size of all number with capacity

MS SQL databases amount of storage

on the Server precision — two where the
decimals database is.

4.3.3 The Settings panel of the Video subsystem section

The Video subsystem section is designed for advanced setup of the video subsystem in order to enhance the
performance of Axxon PSIM.

The settings panel for the Video subsystem section is shown in the figure.
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o[> Windows Nidan subsustam
S Do Auon PSIM Video subsysten
[ DNS Ring
- [» Vistor management system
[» Distributed corfiguration me 1
MEDE IS 20 ) configuration o
Frame count f_‘r_loﬂ .
2 IE——0
Analog video output
Recording time _ "| 7
Bkl Use virtual grabber §
Restart recording on entering the archive [] Hide mask g

1
k
L

Rebuldindex | §

[] Automatic fort size selection for export

[] Gradual increment of camera tile
[] swap frame ficlds 14 [ Pause playback at archive ertry
[] Use PureVideo/CLUDA hardware acceleration

Step of digital zoom scale Maximum ratio
of digital zoom

C—

Cameras without video compression

17

Axxon PSIME Advanced Setup

The parameters of the settings panel are described in the table.
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Parameter Field type Description Representa Default Valuerange

name tion value

The Ring Enterthevalue  Setsfree disk space; MB 5000 Depends on the disk
field in the field when the limit is space

reached the earliest
recordings will be
deleted on loop
(see General
information on
video archiving). If 2
or more disks are in
use for video
archiving, archiving
on current disk is
performed till there
is FreeMbCritical of
free disk space
(1000 Mb by default,
see the info on the
key in Registry keys
reference guide).

Free space set by
the Ring parameter
is used for
recording
temporary files.
This means that
when the limit set
by the Ring
parameteris
reached, the
maximum size of
the temporaryfile is
Ring (registry key
FreeMb). Video can
contain less frames
than set by the
Frame count
parameter.

Note. Old recordings
may get deleted
before the
remaining disk
space reaches the
specified value if the
disk space is less
than 15000
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5

Parameter
name

The Frame
count field

The
Recording
time list

The Record
restart
when
entering
the archive
checkbox

The Rebuild
index button

Field type

Enter the value
in the field

Enter the value
in the field /
select from the
list

Enter the value
in the field /
select from the
list

Click the
button

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Sets the maximum
number of frames in
one recording file

Sets the length of
the file in seconds,
restricting
fragment’s size not
by number of
frames but by time
of its recording

Enables restarting
record on archive
entering

Deletes the
database index file.
After deleting the
index, restart Axxon
PSIM for a new
index to be created

Representa
tion

Frame

Timein sec

Integer

Default
value

1500

0

No

Value range

1500 to 10000. Itis
not recommended to
change the default
value

Unlimited

0 - patch that has
been recorded on
archive entering is
stopped and a new
one starts. As a result
the user who enters
the archive sees a
freeze frame
corresponding to that
on exiting

>0 - the recording is
restarted when
entering the archive,
while positioningin
the archive is carried
out with a shift back
to the specified value
in seconds

-1 - recording is not
stopped on archive
entering
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Parameter
name

The Priority
dropdown
list

The Analog
video
output drop-
down list

The Use
virtual
grabber
checkbox

The Hide
mask
checkbox

Field type

Select the
value from the
list

Select the
value from the
list

Set the
checkbox

Set the
checkbox

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Sets the priority of
all Axxon PSIM video
system processes

Selects analog
output operation
mode

Allows access to
virtual Video
Capture Devices
settings (grabber) in
Axxon PSIM.

Note. Desktop
Experience Feature
is to be enabled
when using a virtual
video capture device
on server OS and avi
files

Prohibits displaying
video hidden with
the motion detector
mask. Video area
marked with
motion detector
mask will be grey-
filled. This feature
supports only
uncompressed
video from FS or FX
video capture cards

Representa  Default
tion value
Names of Below
priority normal
processes

Names of All
available

modes

Boolean No
type

Boolean No
type

Value range

Realtime, High,
Above normal,
Normal, Below
normal, Low

All - video signals
from all the analog
outputs are displayed
on one screen

One - video signal
from one analog
outputis displayed
on one screen

Yes - the Virtual
value is available
from the Type drop-
down list on the
settings panel of the
Video Capture
Device objects

No - the Virtual value
is not available for
the Video Capture
Device objects

No - video hidden
with the mask is
displayed

Yes - video hidden
with the mask video
is not displayed
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Parameter
name

Field type

The Set the
Automatic checkbox
font size

selection for

export

checkbox

The Gradual  Set the
increment checkbox
of camera

tile

checkbox

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description Representa Default
tion value

Enables therelative ~ Boolean No

font size for type

captions (camera

No. and time) when

exporting a frame

or fragments of the

video archive

Enables a gradual Boolean No

increase of the type

Video Surveillance
window on the
custom layout by
double-clicking the
left mouse button.
All Video
surveillance
windows on the
layout should be
the same size to
ensure proper
operation of the key

Value range

No - when exporting
a frame, regardless of
the video resolution,
the caption size
remains constant as
set by the
SubtitlesFontSize
registry key, see

the Registry keys
reference guide.

Yes - when exporting
a frame, the caption
size is scaled
depending on the
video resolution.

No - the Video
surveillance window
is expanded to the
entire Video
surveillance monitor
by double-clicking
the left mouse
button.

Yes - by double-
clicking the left
mouse button, the
Video Surveillance
Window is enlarged
gradually: the first
double-click enlarges
it 2 times of the initial
size, the second
double click enlarges
3 times of the initial
size, etc. The Video
Surveillance
Windows adjacent to
it are hidden on the
layout.
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[

Parameter
name

The Swap
frame fields
checkbox

The Use
PureVideo/
CUDA
hardware
acceleration
checkbox

The Pause
playback at
archive
entry
checkbox

The Step of
digital zoom
scale field

The
Maximum
scale of
digital zoom
field

Field type

Set the
checkbox

Set the
checkbox

Set the
checkbox

Enter the value

in the field /
select the
value from the
list

Enter the value

in the field /
select the
value from the
list

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Switches Axxon
PSIM from basic to
additional driver if
there are video
artifacts while using
basic driver

Enables PureVideo/
CUDA support on
the Server while
decompressing
video from IP
devices if PureVideo

HD card of the 2"

or 3™ generation
(NVIDIA VP2 and
VP3) is installed.
Used to reduce
Server load due to
resources of
graphics processor

The Pause button is
pressed on archive
entering

Specifies the
fractional step of
video image
zooming

Specifies the
maximum value of
digital zoom of
video image

Representa  Default
tion value
Boolean No
type

Boolean Yes
type

Boolean No
type

Real 2,00
numbers

with the

fixed point

Numbers 16

Value range

No - Axxon PSIM
operates with basic
driver

Yes — Axxon PSIM
operates with
additional driver

No - PureVideo/CUDA
isnotin use

Yes - PureVideo/
CUDA isin use

Yes - the Pause
button is pressed on
archive entering,
archive navigation
using arrow keys

No - the Pause
button is not pressed
on archive entering

Maximum value
depends on the
maximum scale of
digital zoom (see.
Nel7).

Minimum value is
1,00

1-16
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N Parameter
0 hame

1 The Camera

7  without
video
compressio
ntable

() Note

Field type

Enter the value
in the field

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Specifies the
numbers of
cameras connected
to the video capture
cards with
compression. There
is no compression
for these cameras,
i.e. the compressor
settings in Axxon
PSIM are ignored

Representa
tion

Camera’s
serial
number

Default
value

Value range

Depends on the
number of cameras
registered in the
system

Setting the non-zero value to the Recording time parameter does not exclude the Frame count
parameter. If the values for both parameters are set, then the file recording will be performed in
accordance with the value which comes first. For instance, if the value of Recording time is equal to 10
seconds and Frame count is equal to 500 frames (by default) and in ten seconds the fragment consists of
80 frames, then 80-frame file is recorded.

4.3.4 The Settings panel of the Testing video capture cards section

The Testing video capture cards section is designed to test the connection of the cameras to the video capture

card.

(@ Note.

To use this functionality Axxon PSIM is to be logged off. Otherwise there is “Cards not found” message.

The settings panel for the Testing video capture cards section is shown in the figure.
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[ windows
- [ Awmon PSIM

Vi istosnen agemeibeystem FS 5/6/8/14/16 code1E4CT
[» Distributed canfiguratian

o[> MSDE (M3 50L) configuration Charinels stats
[\ i pabey oo Channel 3 State

Testing video capture cards l
[ PT

.. [> POS

- [ Yersion

X

Dizconnected

Digzonnected

Dizconnected

Dizconnected

Dizconnected

Dizconnected Checki ng

Dizconnected

= result:
isconnected

Dizconnected SUCCGSS

Dizconnected

1
2
3
4
13
g
7
g
g

Dizconnected

Digzonnected

Dizconnected

Dizconnected

XX KKK KKK KX

Dizconnected

% Axxon PSIM® Advanced Setup

The parameters of the settings panel are described in the table.

Param Field Description Represent Defaul Value range
N eter type ation t
0 name value
1  The Dropd  Specifies the video capture card List of - Depends on the
Board own which camera connections are to be video number of installed
dropd list checked capture video capture cards
own cards
list
2 The  Click Starts the testing process of the - - -
Test the video capture card. The Axxon PSIM
butt  button  systemisto be closed at the time of
on testing.

The Channels state table

3 The Autom  Displays the channels numbers of the - - From 1to 16
Chann atically selected video capture card
el
colum
n

Tweaki.exe utility for advanced setup of the Axxon PSIM software system- 63



Param Field
N eter type

0 hame

4 The Autom
State atically
colum
n

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Displays the state of camera
connections to the channels of the
selected video capture cards

4.3.5 The Settings panel of the PTZ section

The PTZ section is used for setting the telemetry control elements.

The settings panel for the PTZ section is shown in the figure.

e [ Windows

- [ Awon PSIM

> DNS

i[> Wigitor management system
i[> Distributed corfiguration

Delay between commands {ms)

0 1

.. [> MSDE (MS SQL) configuration el oy primitriins)
- [» Video subsystem

mating video capture cards

T

00 |2

Joystick
i o e
5

% Axxon PSIME Advanced Setup

The parameters of the PTZ settings panel are described in the table.

Represent
ation

Defaul
t
value

Value range

Attach - camerais
attached

Detach - camera s
detached
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N Parameter

0 hame
1 The Delay
between
commands
(ms) field

2  The Delay by
priority (ms)
field

3 The
Sensitivity
(1-10) field

Field type

Type-in the
value

Type-in the
value

Enter the
value in the
field

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

Description

Sets the delay time
between executing the
commands for PTZ
devices

This parameter is not
supported by IP
cameras.

Sets the delay time
before switch from the
PTZ control to a user
with lower or equal
priority.

Representati  Default
on value

ms 250

ms 30000

The Joystick group

Sets sensitivity of the
joystick: the less value
the more sensitivity. If
value of parameter is
small then camera will
react on even small
deviations of the
joystick. If value of
parameter is great the
camera will stay fixed
until significant
deviation of joystick

Sensitivity in 5
conditional
units

4.3.6 The Settings panel of the POS PSIM section

The POS-psim.section is designed for setting the POS PSIM module for controlling cashier operations (is not
included in Axxon PSIM basic version). Detailed information about POS PSIM configuring using the tweaki.exe utility
is presented in The settings panel for the POS sections using the tweaki.exe utility section in the Administrator's
Guide documentation for POS PSIM software package.

Value range

No limitations. It
is not
recommended to
change the
default value.

No limitations. It
is not
recommended to
change the
default value.

1-10
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e [ Windows
E-[> Moon PSIM
.-[> DNS
[> Visitor management system
[» Distributed configuration
i[> MSDE (M5 SQL) corfiguration
- [» Video subsystem

Save data to fil
- [ Testing video capture cards B

Folder: Axxon PSIM\Modules\PosCapture | Openfolder
] Allow to specify recognition settings
[ Convert DOS to Windows codepages
[ Use UTF-8

% Axxon PSIME Advanced Setup

4.3.7 The Settings panel of the Version section

The Version section provides information about Axxon PSIM software modules: versions, paths to executable files
and .dll libraries, file sizes and dates of creation and modification.

The settings panel for the Version section is shown in the figure.
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Windows

D W il File Version Full path Size
- [» Distibuted configuration 1 idb exe 1.0.0.280 C:\Program Files ... | 1089024

- [ MSDE (MS SQL) corfiguration idb i Nat found C:\Program Files ... 1753
Video subsystem g 7
Testing video capture cards libeay32 di 102 C\Program Files ... [1281024
PTZ map ini Mot found C:\Program Files ... |56
= ProfUlS252m10.dll |25.2.0 C:\Program Files ... | 3162112
PSIM_exe 1.0.0.280 C:\Program Fi... 14927360
PSIMRunService... | 1.0.0.280 C:\Program Files ... | 48128
PSIM_Host exe 1.0.0.280 C:\Program Files ... | 4422656

SlaveSettingsxml | Not found C:\Program Files ...

slave_compresso... | Not found C:\Program Files ...

ssleay32.dll 1.0.2r C:\Program Files ...

YN EXE 1.0.0.280 C:\Program Files ...

sync xml Mot found C:\Program Files ...
logdnet dil 12100 C:\Program Files ...
logdnet xml Mot found C:\Program Files ...
Mewtonsoft Json dll | 9.0.1.15813 C:\Program Files ...

% Axxon PSIME Advanced Setup

4.4 Typical tasks concerning system extended settings

4.4.1 Selecting and enabling the debug mode of Axxon PSIM software

On the page:

« Enabling debug mode
« Configuring log keeping

Debug mode is a special operation mode when the Debug Window is open, and is designed for analyzing the
progress of Axxon PSIM software operation and for prompt debugging in case errors occur. Log files are created in
this mode - they are stored on the disk for a specific time period.

Tweaki.exe utility for advanced setup of the Axxon PSIM software system- 67



PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

W Debug window

Clear Colors Filter [ apply filter [Juse regex Search

Event : SLAVE|DESKTOP-7932GGS|PING [slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 > module <video.run > date < 27-08-22 >, ver_type<0>,guid_pk<{E2989C1E-F125-ED11-B8DF-B8 70F4FEDSAA} >, core_global < 1, time < 14: 1!
Event : SLAVE|DESKTOP-7932GG2|PING |slave _id <DESKTOP-7332GG% »,onner <DESKTOP-7932GG2 »,module <video.run > date < 27-08-22 > ver _type<0>,guid_pk«<{35071831-F125-ED11-B80F B3 70F4FEDSAA} >, core_global < 1>, time <14: 1!
Event : SLAVE|DESKTOP-7932GG9|PING|slave_id <DESKTOP-7932GG4 >, owner <DESKTOP-7932GG9 »,module <video.run > date < 27-08-22>,ver _type<0>,quid_pk<{A2EDCE44-F125-ED11-B8DF-BETOF4FEDSAA} > core_global <1, time<14:1
Event : SLAVE|DESKTOP-7932GG9|PING|slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 >,module <video.run > date <27-08-22 >, ver_type <0 >,guid_pk <{CBDD4557-F125-ED11-B3DF-B870F4FEDSAA} >, core_global<1x,time<14:1
Event : SLAVE|DESKTOP-7932GGS|PING |slave _id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 >,module <video.run > date < 27-08-22 >, ver_type<0>,guid_pk<{A45DF 16A-F 125-ED 11-B8DF-B870F4FE0SAA} =, care_global< 1>, time<14:1
Event : SLAVE|DESKTOP-7932GG2|PING |slave _id <DESKTOR-7332GG% »,onner <DESKTOP-7932GG2 »,module <video.run > date < 27-08-22 >, ver _type <0 >,guid_pk«<{F2660D78-F125-ED11-B80F B3 70F4FEDSAA} >, core_global < 1>, time <14: 1
Event : SLAVE|DESKTOP-7932GG2|PING|slave_id <DESKTOP-7932G64 >,0nner <DESKTOP-7932GG9 =,module <video.run = date <27-08-22 >, ver_type<0 =,guid_pk<{7351BABB-F125-ED11-B8DF-B370F4FENSAA} =, core_global < 1>, time < 14: 1§
Event : SLAVE|DESKTOP-7932GG9|PING|slave_id <DESKTOP-7932GG9 >, owner <DESKTOP-7932GG9 >,module <video.run > date <27-08-22 >, ver_type <0 >,guid_pk <{9849649F F 125-ED 11-B8DF-BS70F4FENSAA} > core_global < 1>, time<14: 1€
: SLAVE|DESKTOP-7932GGS|PING slave_id <DESKTOP-7932GGS >, owner <DESKTOP-7932GG9 >, module <video.run>,date <27-08-22,ver_type<0>,quid_pk<{C1907782-F125-ED 11-88DF-B8 70F4FENSAAY >, core_global< 1>, time < 14: 199

Enabling debug mode
By default, debug mode is disabled. To enable debug mode, do the following:

1. Shut down Axxon PSIM.
2. Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility)
3. Select the Axxon PSIM node in the tree on the left side of the utility dialog box.
4. Change the parameter Debug Mode from None to Debug 1, Debug 2, Debug 3 or Debug 4 (see The Settings
panel of the Windows section).
Click the OK button.
6. Start Axxon PSIM.
The Debug window item will appear in the Axxon PSIM main control menu.

o

Run

About program...
L3 Debug window
| || System settings

|lj| Leg off

7. Select Debug window in the main control menu to open the Debug window. The selected item will be
marked with a tick.

About program...

Debug window
| System settings

Log off

To hide the Debug window, select the Debug window item in the menu once more.

(@ Note

The debug mode slows the system down and uses a lot of system resources. We strongly recommend to
enable debug mode for debugging purposes only and to disable it when all the settings are completed.
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(@ Note

Find details in the The Debug window section of Programming Guide (JScript).

Configuring log keeping

One can set log keeping parameters both on the Axxon PSIM setting panel in the Tweaki.exe utility (see The Settings
panel of the Axxon PSIM section) and using some registry keys:

1. The Time of log keeping (hours) parameter means the same as DebugTime registry key. It specifies the
number of hours for keeping log files. 48 hours by default.

2. The Maximum size (MB) parameter means the same as DebugSize registry key. It specifies the number of
megabytes provided for log. 100 MB by default.

3. The DebugZipDays registry key enables the logs archiving in the .gz format and specifies the time period for
their keeping. 2 days by default.

Log files are rewritten when one of these parameters is at its maximum.

Find more about registry keys in Registry keys reference guide.

Example.

The Time of log keeping (hours) is 720 hours (1 month) and the Maximum size (MB) is 100 MB.

One week later the size of log file is 100 MB. It starts being rewritten though the log is kept less than it was specified.

And if DebugZipDays has the value equal to the time period in days to keep logs, then logs are not rewritten - they
are archived in the *.gz format and are kept for so long as it was specified in DebugZipDays parameter.

4.4.2 Extended setup of the distributed architecture

Extended setup of the distributed architecture is performed in the DNS section; it is intended to create reserve
connections between the Client and other cores (Servers) in case of loosing connection with the main core. Reserve
connections are to be set up for each Client individually.

To create a reserve connection between the Client and a core, do the following:

1. Stop the Axxon PSIM software if it was running.

2. Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).

3. Select the DNS node in the tree on the left side of the utility dialog box (see The Settings panel of the DNS
section).

4. Specify the core computer name and IP-address in the table.

5. Click OK.

4.4.3 Changing computer names and IP addresses in the Axxon PSIM configuration
database

The Distributed configuration node allows changing the computer name and/or IP address in the Axxon PSIM
database.

To change the computer name in the configuration database, do the following:

1. Shutdown Axxon PSIM if it runs.

2. Start the tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility).

3. Select the Distributed configuration in the tree on the left side of the utility dialog box (see The Settings
panel of the Distributed configuration section).
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4. Select the database containing the computer name to be changed using the Select database (1) or Use
current DB (2) buttons.

Windows
) Axxon PSIM
o[> DNS
i [ Visitor management system
i. [ Distributed configuration :
i Availabl ;
‘.. [> MSDE {MS SQL) configuration sbcem s i

Video subsystem System identifier Mame
Testing video capture cards 3 LOCALHOST

FTZ
POS 3
Wersion

Distributed coi

Select database 1 or | Use cument DB

MNew system 1D
|LOCALHOST

Update protocol 5
[ clear protocal ﬁ

[ Update DB

OBJ_YITU_CLIENT...OK

OBJ_ZONE..OK
UPDATE_PERSON_LOG.. OK
OBJ_SLAVE..SET NAME LOCALHOST.. OK
PROTOCOL..OK

Change |P address

9 | > [127001

& Axxon PSIME Advanced Setup

As a result the Available systems (3) table will show all computer names registered in the selected
database.

5. To select the computer name to be changed in the Available systems table, right-click an appropriate row.
The row will be highlighted.

6. Click the button next to the New system ID (4) field to see the drop-down list of available computer names.
Select the required computer name in the list. The selected name will appear in the New system ID field.
Name can also be entered in the field manually.

7. Setone of the following checkboxes: Update Protocol (5) checkbox to replace the computer name in the
events log, or the Clear protocol checkbox to delete all records in the log. Only one of two checkboxes
should be set.

8. Click the Update DB button (7). The progress of replacing computer names for a new one will be displayed in
the field below the Update DB button (8).

To change the IP address in the configuration database, do the following:

1. Do steps 1-4 of the previous instructions.

2. Select the IP address to be replaced from the drop-down list (9).
3. Enteranew IP address into the field (10).

4. Click the Edit button (11).

The IP address in the database will be changed.
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4.4.4 Limiting memory usage by an MS SQL server

A certain amount of disk space is allocated for the SQL server for storing its data, functions and other internal
structures. Allocated RAM is determined by default by the total RAM resources available for the SQL server in the
system. The Tweaki.exe utility allows limiting the amount of RAM allocated for the SQL server. Do the following:

1. Close the Axxon PSIM software if it is open.
2. Start the Tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility section).

w2 Windows MSDE (MS SOL) = T
H MiSLIE V> 01 ) co [ LUFatlo
B fon PSIM MSBPE (M __[) DRIIGUrAELON
- [> DNS T
[ Vistor management system Select database 1
[> Distributed configuration Maximum memary usage (MEB)
(Bl MSDE (MS SQL) configuration
[ Video subsystem 3
[> Testing video capture cards
G PTZ S0L database size: GEB
[ POS
e [ Version

ar

% Axxon PSIME Advanced Setup

Select the Configure MSDE (MS SQL) node in the tree on the left side of the utility dialog box (see The
Settings panel of the MSDE (MS SQL) configuration section).

Select the MS SQL database to limit the allocated RAM by doing one of the following using Select

database (1) or Use current DB (2) buttons.

In the Maximum memory usage (MB) (3) enter the required amount of memory to be allocated for the SQL
server.

Click the OK button (4).

4.4.5 Re-indexingthe audio and video recordings archive

To re-index the audio and video archives, do the following:

1.
2.
3.

Close the Axxon PSIM software if it is open.

Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).

Select the Video Subsystem node in the tree on the left side of the utility dialog box (see The Settings panel
of the Video subsystem section).

Click the Rebuild Index button to delete the INDEX folder with .idx files containing the indexes to the video
recording files in the archive.

() Note.
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Pressing the button Rebuild index sets the value of parameter IndexRebuilding=1 in the register’s
branch of OS Windows: HKLM\SOFTWARE\AxxonSoft\PSIM\VIDEO for 32-bit system
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\VIDEO for 64-bit). Alterarchive reindexing the
value of the parameter IndexRebuilding=0 is automatically set. When Axxon PSIM software is run
together with IndexRebuilding=1 parameter, the archive is reindexed without any attempt to reas it
from *.idx files.

5. Click OK.
6. Start the Axxon PSIM system again. A new INDEX folder will be created in the video archive folder, containing
new indexes.

This completes re-indexing of the database.

4.4.6 Enabling the Pure video/CUDA hardware acceleration

It is possible to enable the PureVideo/CUDA hardware acceleration when video signals are decompressed from IP
devices. In this case decompression may be carried out by Server’s graphics processor and this reduces the load on
CPU.

A Attention!

It is recommended to update the driver of the card that supports the PureVideo/CUDA hardware
acceleration. Drivers are available for downloading at the official web page of NVIDIA (www.NVIDIA.com).

(@) Note.
Detailed information about the PureVideo/CUDA hardware acceleration is given in reference manual of
NVIDIA company.
The PureVideo/CUDA hardware acceleration functionality is implemented correctly when Server meets the
following requirements of the software platform:

1. Is managed by OS Windows XP/Vista/7.
2. The PureVideo HD video card of the second or third generation is installed (NVIDIA VP2 and VP3).

() Note.
Widespread models of video cards that support the PureVideo/CUDA:

1 NVIDIA GeForce GTX 295;

2 NVIDIA GeForce GTX 285;

3 NVIDIA Quadro NVS 450;

4 NVIDIA GeForce 9800 GT;

5 NVIDIA Quadro NVS 420;

6 NVIDIA Quadro NVS 295.
() Note.

In the Axxon PSIM software package the PureVideo/CUDA hardware acceleration is applied only for video
signals’ decompression in H264 codec.

(@ Note.
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If the resolution more than 1920x1088 is set in the camera, then the PureVideo/CUDA hardware
acceleration is not used for video signals’ decompression.

To enable the PureVideo/CUDA hardware acceleration, do the following:

1. Shutdown the Axxon PSIM software package if it was run on the computer.

2. Runthe Tweaki.exe utility (See the Starting and shutting-down the Tweaki.exe utility section).

3. Select the Video subsystem section in the tree in the upper left corner of the utility’s dialog box (see The
Settings panel of the Video subsystem section).

4. Setthe Enable PureVideo/CUDA hardware acceleration checkbox.

5. Click the OK button.

Go to the settings panel for the Camera object.

Hardware I Pro

phure device Ml Dizable

Video capiure device 1 v
- -

i o5k
FFmpegallinOnelecoder
H2B45veEx

L H2645veTEx
Irted Quick Sync
U Motion Wavelet 35
P Mation Wavelet B5

Cameia positian

“Wiible part:

7. Inthe Decompressor drop-down list select the H264CudaVP2Decoder value.
8. Click the Apply button.

The PureVideo/CUDA hardware acceleration is now enabled.

4.4.7 Testingvideo capture cards

To test a video capture card, test its channels using the Testing video capture cards module of the Tweaki.exe
utility. Do the following:

1. Shut down the Axxon PSIM software if it is started.

2. Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility section).

3. Select the Testing video capture cards node in the tree on the left side of the utility dialog box (see The
Settings panel of the Testing video capture cards section).

4. Press Test button.

The Board field will display the name of the video capture card, and the Channels state table will show the
information about each channel of the card (number and status). The confirmation of successful testing will be
displayed to the right of the Channels state table.
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5 The utility for collecting configuration data on servers and RWS
for the Technical Support

5.1 The purpose of the Support.exe utility

The Support.exe utility is designed for collecting information about the configuration and operating status of the
hardware, OS Windows and the Axxon PSIM™ system. The utility generates an archive that can be used by AxxonSoft
Technical Support Service for troubleshooting purposes. In case of system malfunction or errors in the Axxon PSIM™
system, do the following:

1. Go to the AxxonSoft tech support server: https://support.axxonsoft.com/.
2. Register a new account on the tech support server or log in the registered account.
3. Create anissue for tech support. Attach an archive generated by Support.exe utility.

Information on the issue progress will be sent to the email specified at registration.

@ Howto gettechnical support

5.2 Starting and shutting-down the Support.exe utility

To run Support.exe utility, use one of the following methods:

1. From the Start menu of OS Windows: Start -> All programs -> Axxon PSIM -> System’s information
gathering utility
2. From the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Tools\Support.exe

After running the Support.exe, the Support - Collecting info about system utility dialog box is displayed.
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Suppaort - Collecting info about system

X

support group.

This application can be used for collecting data about the system and about the installed AxxonSoft software.
Click Collect to create support_[date]_[time].7z file. After that you can send it to AxxonSoft technical

-
so

Collecting dump-iles for the last
Collecting logiles for the last

Collect

Step

Step 1 : Receiving info about installed software

Step 2 : Receiving info about the version of installed modules

Step 3 : Receiving info about the system

Step 4 : Receiving info about the DirectX subsystem

Step 5 : Receiving irfo about HOD

Step & : Receiving info about the key filas

Step 7 : Getting information about the registry settings

Step 8 : Copying corfiguration files

Step 5 : Copying settings files

Step 10 : Copying files of scripts and dialogs

Step 11 : Copying log files

Step 12 : Receiving info about TCP/IP{UDF) ports in use

Step 13 : Receiving info about the types of installed CPU

Step 14 : Getting information about the archives on all disks

Step 15 : Receiving info about the installed hardware

Step 16 : Receiving info about the installed Guardant dongles

Step 17 : Creating an archive copy of the MS SQL Server database
Step 18 : Creating the archive copy of the DB without the protocols
Step 15 : Removing old dump- and log4iles

Step 20 : Compressing files

Sl sRulislisisfolslshislslisiolsisgislislislo] o fis

Step 21 : Removing temporary files

Status

To close the Support.exe utility, click the Close button ().

5.3 The Support interface description

Support.exe utility interface includes the following elements:

1. Short directions for using the Support.exe (1).

Collect button to run the process of gathering information (3).
Filed of displaying the information (4).

A group of settings for specifying data set collection time period (2).

o

Table to display and select steps of gathering information, it includes two columns - Step ans Status. In the
Step column, the short characteristics of information gathering process step is displayed and the step can
be cancelled before the information gathering starts. In the Status column there is displayed process-bar

and time, spent on information gathering (5).
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i+ Support - Collecting info about system . b4

This application can be used for collecting data about the system and about the installed AxxonSoft software.
Click Collect to create support_[date]_[time].7z file. After that you can =end it to AsxaconSoft technical

support group. 1
1
2
1
3 I?Iease wait, data are being onll?cteli. 4
This process may take several minutes ...
Status
: Receiving info about installed software QK {Ds)
Step 2 : Receiving info about the version of installed modules OK{82s)
Step 3 . Receiving info about the system QK {Ds)
Step 4 : Receiving info about the Direct® subsystem CK{11s)
Step 5 : Receiving info about HDD OK{2g)
Step 6 : Receiving info about the key files QK {Ds)
Step 7 : Getting information about the registry settings OK(0s)
Step 8 : Copying configuration files OK{0s)
Step 5 : Copying settings files CK{Ds)
Step 10 : Copying files of scripts and dialogs QK {Ds)
: Copying log files :l

Step 12 : Receiving info about TCP/IP(UDP) ports in use 5

Step 13 : Receiving info about the types of installed CPLU

Step 14 : Getting information about the archives on all disks

Step 15 : Receiving info about the installed hardware

Step 16 : Receiving info about the installed Guardant dongles

Step 17 : Creating an archive copy of the MS SQL Server database
Step 18 : Creating the archive copy of the DB without the protocols

Step 19 : Removing old dump- and logfiles
Step 20 : Compressing files

RINORREEIRFUIRRRERERR R

Step 21 : Removing temporary files

To close the Support.exe utility, click the Close button ().

5.4 Collecting information about videoservers and remote workstations
using the Support.exe utility
To collect the information using the Support.exe utility, do the following:

1. Start the utility.

2. If necessary set the dump and log files collection parameters:

a. Inthe Collect dump files for ___ days field specify the number of days for which dump files are to be
included into the data set for technical support (1).

b. Inthe Collect log files for ___ days field specify the number of days for which log files are to be
collected into the data set for technical support (2).

3. By default, all available system information is collected. If necessary, uncheck the boxes next to the
information collection steps that should be skipped (3). If unchecked, information is not collected at the
corresponding step.

Some stages of information collection are mutually exclusive, for example, you cannot simultaneously select
the Creating an archive copy of the MS SQL Sever database and Creating the archive copy of the DB
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without the protocols checkboxes.
Some steps cannot be excluded, including Compressing files and Removing temporary files.
4. Click the Collect button (4).

The data collection process will start. Upon completion, the result of information gathering on each step is
displayed in the Status column (5), while the information area will show the link to the newly generated file -
support.7z (6).

i+ Support - Collecting info about system . b4

This application can be used for collecting data about the system and about the installed AxxonSoft software.
Click Collect to create support_[date]_[time].7z file. After that you can =end it to AsxaconSoft technical
support group.

Collecting dump-iles for the last l:l days 1

Collecting logiles for the last days 2

Collect 4 Completed! Open folder with file support 09-12-2019 05-12-27.7z 6

Step 3 Status 5
Receiving info about installed software OK{0s)
Step 2 : Receiving info about the version of installed modules OK{82s)
Step 3 : Receiving info about the system QK {Ds)
Step 4 : Receiving info about the DirectX subsystem CK{11s)
Step 5 : Receiving info about HDD OK{2g)
Step 6 : Receiving info about the key files QK {Ds)
Step 7 : Getting information about the registry settings OK(0s)
Step 8 : Copying configuration files OK{0s)
Step 5 : Copying settings files OK{0s)
Step 10 : Copying files of scripts and dialogs QK {Ds)
Step 11 : Copying log files CK{1s)
Step 12 : Receiving info about TCP/IP{UDP) ports in use CK{De)
Step 13 : Receiving info about the types of installed CPLU OKids)
Step 14 : Getting information about the archives on all disks Ermror!
Step 15 : Receiving info about the installed hardware QK{1s)
Step 16 : Receiving info about the installed Guardant dongles Emor!
Step 17 : Creating an archive copy of the MS SQL Server database OK{0s)
[] Step 18 : Creating the archive copy of the DB without the protocols

Step 19 : Removing old dump- and logfiles CK{De)
Step 20 : Compressing files OK(1s)
Step 21 : Removing temporary files OK{Ds)

Follow the Open Folder with Support.7z File link to view the archive (6).
The archive is saved in C:\Users\%current user name%\Documents\Support\.
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6 The Fps.exe utility for productivity estimation

6.1 The purpose of the Fps.exe utility

Productivity measurement fps.exe utility is used to estimate productivity of video processing.
Estimation is done in the following way:

1. Segmentation of the given video fragment for a set of frames in jpeg format.

() Note.
If the video fragment is not set, the utility generates pattern set of frames. When necessary the
utility may store the created set for fames to the selected directory.

2. Compression and/or decompression of the created frame set.
3. Calculation of productivity parameters- number of processed fps with defined resolution and colour.

() Note.

Compression is not available on the Cilent. Playback of a previously recorded video, or a video being
received over the network in real time, is available.

6.2 Starting and shutting-down the Fps.exe utility

To start fps.exe, do one of the following procedures:

1. Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then
FPS testing utility.
The fps.exe utility is available from the Start menu with the following installation types of the Axxon PSIM
software: Server, Remote administrator workstation, Remote client.

2. Start the utility from the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Modules64\fps.exe .

After starting the fps.exe utility there will be a dialog window Video processing FPS tester.

Iox]
Video source: 0; WIDEO\05-03-19 1711, 03 File |

Server |

¥ Compression Check Start |

[V Decompression Check ™ Copy for stream

Codec IAs in source file 'I Stop |
Mumber of channels per core I 1 Number of CPU cores in use |4 ‘I Quality |Med 7
JPEG images storage folder I |

[~ Statistics

The Fps.exe utility for productivity estimation- 78



PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

To close fps.exe utility click Xl inthe right upper corner of the utility’s dialog window.

6.3 Using the Fps.exe utility

On the page:

+ Selecting the
video source

+ Setting the
check
parameters

+ Running the
check and
reading into its
results

To check productivity of video processing, do the following:

=

Start the fps.exe utility (see Starting and shutting-down the Fps.exe utility).
Select the video source.

Set the check parameters.

Run the check and read into its results.

M

6.3.1 Selecting the video source

The video source can be either an archive file or a video server archive recorded on specific cameras.

(@ Note.

The field Video Source File is not required to run the check on an emulated pattern set of frames.

If the video source is an archive file, select it as follows:

1. Click File and then double click the required file in the Windows standard Open box (1).

E Videoprocessing FPS tester o [l 3
Video source: P D: \IDEO\05-03-19 1711 03 1 Fie |

Server |

2. The full name of the selected file is displayed in the Video source field (2).

If the video source is a video server archive, make sure the Axxon PSIM is running on that server and all the required
cameras are created in the hardware tree before performing the check.

Select the archive video source as follows:
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1. Click Server (1). The Cameras dialog box opens.

Video source: | 127.0.0.1, 1, Camera 1 7 File
2 3

) | 127.0.0.1 Get

Cameras: 5 I selectal Start

Mumbe:

[ Statistics

LJEE

6 oK | Cancel

2. InthelP field, specify the IP address of the Axxon PSIM video server (2).

3. Click Get (3). If connection with the server is established, the Cameras field displays the list of cameras.

4. Setthe check boxes next to the cameras to check performance using their archive (4) or set the Select all
check box to select all the cameras in the list (5).

5. Click OK (6).

6. The selected cameras are added into the Video source field (7).

6.3.2 Setting the check parameters
Set the parameters of performance check as follows:

1. Activate Compression check checkbox to check how many fps the given computer can compress (1).

1 ¥ compression Check Start

2 ¥ Decompression Check [~ Copy for stream 3
Codec lm 4 6 Stop
5 MNumber of channels per core ll— Mumber of CPU cores in use m Quality m?
8 JPEG images storage folder I _I

2. Activate Decompression check checkbox to check how many fps the given computer can decompress(2).

3. Select the Copy for stream check box to create a separate copy of each stream file in the RAM in order to
avoid conflicts during the check (3). This function increases memory consumption when running the fps.exe
utility.

4, Select the required compressor version from the drop-down list Codec (4).

5. Enter the required number of emulated cameras in the field Channels amount (5).

() Note.

This setting is actual only with emulation of pattern set of channels.

6. Inthe Number of CPU cores in use field specify the number of CPU cores to be used for performance check
(6).

7. Select the required value of frames compression from the dropdown list Quality (inversely to compression
level) (7).

8. When necessary, set the directory where frames extracted from the video would be unzipped by clicking

_| next to the Jpeg images storage folder field (8).

The Fps.exe utility for productivity estimation- 80



PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

6.3.3 Running the check and reading into its results

Click the Start button to run video processing tester (1).

§ Videoprocessing FPS tester i =1E1x]
Video source: D:\IDED\05-03-19 17\1._03 File
Seryer
™| Gompression Check 1
¥ Decompression Check I | Copy for stream
Codec |As in source file 3 Hy
Mumber of channels per core | L Number of CPU cores in use |+ j Quality IMad j
JPEG images storage folder I _I
[ Statistics
[2019-08-15 17:40:28]

CPU: using 4 CPU cores from 4
Compressors & decompressors per thread: 1

Compression: 0 fps ( ~ live channels: 0)

Decompression: 878 fps ( ~ five channels: 35, decompress time max: 15 ms, ava: 4ms )
Ratio: 0

Version: H264 (63)

Width x Height: 1280 x 720

Color: color

As a result, parameters of video processing productivity will be displayed in the title bar of the utility window (2).

Productivity parameter

Compression

Decompression

Ratio

Version

Width

Height

Color

CPU

Compressors $ decompressors per thread

Description of parameter

total number of frames that can be compressed in one
second

total number of frames that can be decompressed in one
second

compression ratio

selected version of the compressor

frame width

frame height

if the frame isin color

number of CPU cores in use

number of compressor instances per CPU

If the Jpeg images storage folder is selected, the frames for testing video processing will be recorded to the

selected .jpeg files storage folder.

The example of the emulated frame is shown below:
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—

|||II||'||III|I||| 11 T

To stop the testing process, click the Stop button (3).
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7 The ddi.exe utility for editing database templates and external
settings files

The ddi.exe utility is designed for editing external system settings files (*.ddi) and the templates of the main
database (psim.dbi and Axxon PSIM.ext.dbi).

The ddi.exe utility is started from the Start -> All Programs -> Axxon PSIM -> Tools -> System configuration
menu.

The ddi.exe utility is available from the Start menu with the following installation types of Axxon PSIM: Server,
Remote administrator workstation, Remote client.

The utility can also be started from the Tools folder of the Axxon PSIM program folder.

After the changes are made to *.ddi and/or *.dbi files, update the main database. For this use the idb.exe utility (see
The idb.exe utility for converting databases, selecting database templates and making backup copies of databases
section).

(@ Note.

If changes were made to .ddi or .dbi files using the ddi.exe utility and these files were installed along with
Axxon PSIM, then these files will be deleted while deleting with configuration upload. .ddi and .dbi files
added manually will be saved.

7.1 Editing Axxon PSIM.dbi and Axxon PSIM.ext.dbi database templates
using the ddi.exe utility

To edit the template of the main database, open it using the File -> Open menu. The template files are stored in the
root of the Axxon PSIM program folder.

(@ Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the
Names tab.

() Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other
dbi files, to the open dbi file.

psim.dbi file contains the list of main tables and fields of the database. User-defined tables and fields are stored in a
separate file - Axxon PSIM.ext.dbi. This file is made separate from the main file, to eliminate the need to re-insert
user-defined tables and fields into the main file, in case of Axxon PSIM system update. The contents of these files
are merged upon Axxon PSIM start-up.

To view the database template, open the DBI tab in the top left corner of the window. The list of the tables of the
main Axxon PSIM database will be displayed in the left panel. The right panel will show the list of fields of the
selected database.

The ddi.exe utility for editing database templates and external settings files- 83


https://docs.axxonsoft.com/confluence/display/PSIM100en/The+idb.exe+utility+for+converting+databases%2C+selecting+database+templates+and+making+backup+copies+of+databases

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

=0l x|
File
ool Field name Type Size Description

‘ ohijtype CH&R 32

action CHAR 16

-4 FOLDERS parars CHAR 30

3 ESEE;E%_DBJS description CHAR 50

tupe CHAR 5

49 MARKER

-4 MARKERS

-4 OBJPARAM

-4 OBJTYPE

- OBJ_ACTIVER

- OBJL_ACTIVER]

.4 0BJ_ARCH

-4 OBJ_ARCHIVER

-3 OBJ_ARCHIVER_CaM

-4 OBJ_ARCHPAMEL

49 OBJ_ARCHPAMEL Pat SENT =

99 DBJ_ARCH_CAM ulahitype, ]CHAFI, 32 =

- OBL_ATM action, CHAR, 16

4 OBJ_ATHMI pararns, CHAR, 30

-4 DEJ_ATMI_CAMS deszcription, CHAR, 50

9 OBLATM_COLOR_ w1 | e CHAR.S

4P OB ATMI_EVENT i

-4 OBJ_ATMX25_CLIENT

P OBJL_ATMRZ5_CLIEMT,

-4 OBJ_ATMX25_SERVEF

-4 OBJ_ATMX25_SERVEF

AP OBLATM_ITY

-4 0B AUDIO = =
i — | .-
|Objeu:ts in katal :0 v

To delete, add, edit or copy object fields, use the table on the left of the utility box.
The following parameters of the table fields are displayed:

1. Field name - the name of the field in the database.
2. Type - data type of the field contents. Available types:
a. BIT - checkboxes taking logical values Yes and No;
CHAR - fields with a few symbols;
DATETIME - date and time in the following format: date - dd-mm-yyyy, time - hh:mm:ss;
DOUBLE, INTEGER, SMALLINT - numerical fields of corresponding types;
TEXT - fields with the text.
3. Size - maximum number of units of the specified format in a field.
4. Description - field name shown in the interface.

® oo T

The database is to be refreshed after the changes were made.

7.2 Editing the external setting file (Axxon PSIM.ddi) using the ddi.exe
utility

To edit the external settings file (Axxon PSIM.ddi), open it using the File -> Open menu. This file is stored in the root

of the Axxon PSIM program folder.
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() Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the
Names tab.

() Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other
dbi files, to the open dbi file.

The external settings file contains the information about objects and events loaded into the system configuration,
graphical symbols for various object states on the map, and the transition rules from one object state to another.

The purpose of editing can be software localization or expanding/limiting its functionality (for example, removing
unused objects from the system).

() Note.
Changing the external settings file may lead to system failure. Create a backup copy of the file before

editing it.

The database is to be refreshed after the changes were made.

7.2.1 Generalinformation on editing the external setting file
To start using the utility, open the DDI tab in the top left corner of the utility dialog box.

The left side of the dialog box will display all system objects loaded into the configuration. The right side of the
dialog box shows the properties panel for the selected object. This panel consists of several tabs: Names, Events,
Reactions, Icons, States, and Transition rules.

To delete, add, edit or copy object properties, right-click a cell in the tab or the list of system objects to open the
context menu. You can also use Ctrl+C and Ctrl+V to copy and paste lines from one object to another. Select the
whole line(s) or just a cell(s) in it to copy by Ctrl+C. Delete lines with Delete key.

To edit the object properties, use the tables on the right of the ddi.exe utility box.

7.2.2 The Names tab
This tab contains the table with three fields:

1. Object - object ID in the system.

2. Name - the name of the object in the system.

3. Group name - the name of the group the object will be assigned to upon creation. If this field is left blank,
no group will be created. Objects of different types may be assigned to the same group given that they have
the same parent object (e.g., Sensor and Relay can be included to the "Sensors and Relays" group and so
on).

By default all objects, the description of which the ddi file contain, are displayed in the table. To find an object,
type-in the object name or ID in the Search by name field. As a result the table will contain all object names in the
system that exactly or partially match the word typed in this field.
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1:- DDI & DBI Editor - [C: Program Files \WuTennekt'Languages' en’intellect.ddi] = |EI|£|

Filz

ool IDEI I Mames | Eventsl Fleau:lionsl lcans I Slatesl Transitioh rules

CONFIG =]
DEFARTMEMNT Search by name
DIALOG

DISPLAY |od

ggg [bject | Mame Group name
EVEMT_COUMTER 3 Video Capture Card

EVENT_WIEWER
GATE GRAY

Senzar Senzorz

GRABBER PROGRAM Program Programs
GRAY

GRELE

HTTP

KEYE

LEWEL

LMCFTP

LMCGATE

MACRO

MalL_MESSAGE

MAIN

AP

MAPLAYER

MAPPLATFORM b
MESSAGE

M5

MOMITOR

PERSOM

PROGRAM

REGIOMN

REGIOMRULE

RIGHTS

SCEME

SCRIPT -

Total objects: 70

7.2.3 The Events tab

This tab contains the list of the system events that the selected object can create. Each event has the following
editable parameters:

1. Name. The event identifier.

2. Description. A short description of the event.

3. Processing messages. The type of window to open on event occurrence: alarm window or information
window.

4. Support audio. The attached .wav files to be played when the event occurs.

5. Disable network connection. A local event only. If this checkbox is set, other computers on the network will
not be notified when the event occurs.

6. Disable logging. By default, all events are displayed in the Event log. Set the checkbox not to log the event
orrecord it in the database.

7. Windows log. Set the checkbox to log the event (see step 6) to Windows log. If the event is not logged, then
it cannot be logged to Windows log.
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*: DDI & DBI Editor - [ iles' ddi =10l x|
File

Dol |DE| | Mames Ewvents | Heactionsl leans I Statesl Tranzition luIesI

ACTIVER
ARCH MHame
ARCHIVER
HCHEGER OMLINE | LIPS . |mrFor..
ATMRZ5_CLIENT
ATM=25_SERVER

ATM_ITY

CAM

CAM_FACECAFTURE
CAM_IP_DETECTOR
CAM_TITLE

CAM_WMDA =
CAM_WMDA_DETECTOR
CAM_ZOME

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DD

DRS Parameters for event "UPS - AC power supply restored™:

EEEH%&E&‘E&H MNapatieTp HaseaHue Tun | Fnement | 3nausHue

GATE * -
GRAEBER

| »

Dizable
network
connection

Processing

[ezcription messages

Support audio Dizable logging | *Windows log

GRET
GRELE
HTTP
KEYE

LEVEL ﬂ

| RACETD

Total objects: 72

() Note

You can create only the events that are available for the selected object (created at the stage of the system
programming). Initially all of them are in the Axxon PSIM.ddi file.

7.2.4 The Reactions tab

This tab lists all reactions that the object can make in response to events. Each reaction has the following
properties:

1. Reaction - reaction ID.
2. Description - short description of the reaction.
3. Arming - additional property of the reaction, arming a region.
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(- DDI & DBI Editor - [C:%Program Files' MiHTennexkT \Languages' en’intellect.ddi] y - |E||1|
File
ool |DBI | Mames | Events Fieactions | Icons | States | Transtion rules |

COMFIG - Reaction Description Aty
DEPARTMENT 2l l & ‘ 2
DIALOG
DISPLAY

DMD

DRS COMFIRM Classify alarm Il
EVENT_COUMNTER
EVENT VIEWER * r

MACRO
MAIL_MESSAGE
MAIN

MAP
MAPLAYER
MAPPLATFORM
MESSAGE
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MOMITOR
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FROGRAM Parameter Marme Type Element | walue
REGION
REGIONRULE & z
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SCENE

SCRIPT
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SHORT_MESSAGE
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SMS

555_SHMP
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G55 WATCHDNR LI

Parameters of action "Arm":

Total objects: 70

(@ Note.

You can create only the reactions that are available for the selected object (created at the stage of system
programming). Initially all of them are in the Axxon PSIM.ddi file.

7.2.5 Thelconstab

This tab lists the graphical symbols (icons) that represent the selected object on the map. The part of the name
used for identifying the file in the .bmp, .jpg or .png format is specified in the File name column. Image files are to
be stored in the Bmp folder in the Axxon PSIM program folder (for example, C:\ Program Files\Axxon PSIM\Bmp).
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(‘- DDI & DBI Editor - [C:Program Files'MuTennexT' Languages'en’intellect.ddi] ) ] - IElllI

File
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Tatal abjects: 70 L |

If default icons are to be in use for the same states of objects of the same type, the def icon should be specified on
this tab (By default). See The States tab section for more information.

"MNames | Everts I Reactions lcons |State5 I Transfer ules I

File name Name
cam Standard
camptz PTZ
camfisheye Fisheye

-

7.2.6 The States tab

This tab lists all states of the selected object. The states have the following properties:

1. Name -stateID.

2. Image - part of the name in the .bmp format that represent the object state on the map. For example, if the
zone_fire file name was selected in the Icons tab, and the image of the selected ARMED state is arm, then the
zone_fire_arm.bmp file will be in the Bmp folder.

The default icon for the states can be set. For this, set the def icon (By default) on the Icons tab. For example, if
there is no zone_fire_arm.bmp icon for the ARMED state, then the def_arm.bmp icon will be searched. This avoids
duplicating icons if one state for the different types of the object icon should be displayed identically.

() Note.

If the file ID is not set in the Icons tab, then the file name will consist of the object ID and part of the file
name specified in the Image column.

(@ Note.
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If the object is displayed on the map as a polygon, circle or line, then the color of these figures can be set

for each state.

For this specify the color in the R:G:B:A format after the icon name (separated by &) in the Image column
or specify the color only in this format instead of the icon name. Here are the examples of the Image

column contents:

255:0:0 - red color is set for the state.
alarm&255:0:0 - icon and red color are set for the state.

1. Description - short description of the state.
2. Flicker when alarm - option of displaying object state - flickering.

',- DDI & DBI Editor - [C:\Program Files',MuTennexkt’Languages'en'intellect.ddi]

File:
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Total objects: 70

7.2.7 The Transition rules tab

Transition rules connect the events generated by objects, and the states of these objects. Each rule consists of the
starting state of the object, an event, and an ending state that the object will take after the event.

The table lists the transition rules from one object state to another. Each rule has the following properties:

1. Event - identifier of the event triggering the transition.
2. Transition from state - identifier of the object state before the event took place. If this field is left blank, the

rule will apply to all starting states.
3. Transition to state - identifier of the resultant state of the object.
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Jintellect.ddi]
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7.2.8 Example of editing the Axxon PSIM.ddi file to reduce database load

When changing the ddi file events, reactions, etc. can be added, modified or deleted.
To reduce database load modify the AxxonPSIM.ddi file as follows:

1. Open the AxxonPSIM.ddi file in the ddi.exe utility.

2. Select the CAM object.
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Total of objects: 79

3. Gotothe Events tab.
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4. Setthe Do not record and Do not send to the network checkboxes checked for the MD_START (Alarm) and
MD_STOP (Alarm end) events.

5. Save thefile.

6. Update the database using the idb.exe utility (the Update database button, see Interface elements of the
idb.exe window).

When these actions are performed the events from the main motion detection tool are not recorded and sent to
other cores. This reduces the database load.

A Important!
When updating Axxon PSIM the modified AxxonPSIM.ddi file is substituted with the file by default.
In order the AxxonPSIM.ddi file is not substituted it is to be saved with another name at step 5 - e.g.
"AxxonPSIM_1.ddi". Thus, 2 files of external settings are saved in the Languages catalog: source file and modified

one. The idb.exe utility loads them in alphabetical order. As a result the AxxonPSIM_1.ddi file is loaded the last one
and its parameters are applied when database is updated.

If the event list in AxxonPSIM_1.ddi is different from the original Axxon PSIM.ddi, e.g. some events are added or
deleted, then the event list is merged by idb.exe DB update.

When installing a new Axxon PSIM version the AxxonPSIM_1.ddi file is not affected by the installation wizard and
changes are saved.

& mportant!

When deleting Axxon PSIM without saving the configuration the entire Axxon PSIM catalog (including
modified files) is deleted. In this case the modified files are to be manually backed up, e.g. to C:\Temp,
under after reinstallation they are to be copied to <Axxon PSIM installation folder>\Languages\en.
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8 The Arpedit.exe utility for creating user dialog windows

The Arpedit.exe utility is designed for creating dialog boxes. It allows tailoring Axxon PSIM™ system to particular
monitoring and security tasks of the customer.

The Arpedit.exe utility is in the “Arpedit” folder (<Installation directory>\Axxon PSIM\Tools\ Arpedit). Detailed
information on the utility is given in User's Manual for ArpEdit which is located in the same folder.
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The Configuration check tool is designed for checking the settings of all created objects in the Axxon PSIM™
software and restoring the correct configuration if any changes occurred. Restoring is performed from the
configuration template which can be created at any moment in accordance with current settings.

9.1 Starting and shutting down the Configuration check tool

To start the Configuration check tool, do the following:

1. Go to the Interfaces tab of the System settings dialog box.

?IEI E:Ii::Fll-El':." 1

- Display

Change parameter, ..

Delete object

% (Create folder...

Find. ..

&
]
CF
(3 Save
e
=
=

Load canfiguratian, ..

Save configuration...

£

Frogramming

Prograrming

Audio plaver

Configuration check

i EHE" mEM. OB RS

(LI

Event viewer

External window
Fishewe camera monitor
Live sound switch

Map

Manitar

Monitoring client
Cperakor protocol
Panel of Long-term archive
Scene

Search by captions

Telemetry control panel

Displaw
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3. Go to the settings panel for the Configuration check object.
b1l —

1 Configuration check 1
I I X |44_ |44
Display ™ Dizable
i |44 H: |44
’ _ 1
| Dizplay 1 ﬂ Manitar:

-

Cancel

4. To configure the position of the Configuration check object, set the coordinates of upper left cornerin Xz, Y:
fields and values of window’s width and height in W:, H: fields, and select the computer monitor for which
the coordinates are set (1).

5. To save the changes, click the Apply button (2).

As a result the Verifying configuration tool dialog box is displayed.
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Yerifying configuration tool

File  Configuration  Debug

|:| LOCALHOST |8:|:’2l =
“onfiguration check 1 —

= P. ters from
flags
quid {264CBOEA-6C33-E011-B4F5-001AADDAE 3BC}
h 30
narme Configuration check 1
parent_id 1
w 0
b 0
Y 30

flags
Template [ Diistinguish ] [ Corect

EE

E Parameters from template
flags
quid {264CBOEA-6C33-E011-B4F5-001AADDAE 3BC}
h 30
name Configuration check 1
parent_id 1
w 0
® 0
¥ 30

flags

mE
To shut down the tool, click the button on the main control panel of Axxon PSIM™ software and select the
Close all menu item;

> Close all

Display 1

9.2 Configuration check tool interface description

The dialog box of the Configuration check tool has four main interface elements:

1. Thetoolbar (1).
The tool’s control menu is located here.

2. The objects tree of Axxon PSIM™ software (2).
The objects tree of Axxon PSIM™ software is displayed here. Clicking the left mouse button on any object in
the objects tree, the configuration of its parameters is displayed in parameters field (points 3-4).
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3. Thefield of object parameters from Axxon PSIM™ configuration (3).
The current configuration is displayed in this field. These parameters are not available for editing.
4. The field of object parameters from a template (4).

Parameters of the selected object from the configuration template field are displayed here. These parameters are
available for editing.

() Note.

At the first start of the Configuration check tool, the current configuration of selected object is displayed in
this field.

Verifying configuration tool

File  Configuration  Debug

.

Template Distinguish ] [ Correct

D | A

BEE

E Parameters from template
flags

quid {264CBOEA-GC33-E011-B4F5-001AAODAE 3BC
h 30
name Configuration check 1
parent_id 1
w 0
® o
v 30
guid
\ 4

9.3 Using the Configuration check tool

To start the operation, start the Configuration check tool (see the Starting and shutting down the Configuration
check tool section).

9.3.1 Creating atemplate

To create a template in the Configuration check tool, do the following:
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1. Inthe objects tree, set the checkboxes next to those objects which parameters configuration will be included
in a template.
ISl | Computer

----- [ Long-term archive 1

----- [ Long-term audio archive 1

-- Yideo Capture Device 1
- [ dudio card 1

----- [ Audio card 2

2. Click the left mouse button upon the object which parameters configuration is to be edited.

() Note.

The set checkbox next to the required object is an obligatory term in order to edit the parameters.

As aresult there is a list of object parameters with values, available for editing in the parameters from
template field.

() Note.

In the parameters from Axxon PSIM configuration field there is a list of object parameters with
values set in Axxon PSIM software. They can not be edited.

E Parameters from configuration

(@ Note.

At the first start of the Configuration check tool, the current configuration of selected object is
displayed in this field.
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=05
flags
format
quid
ip
ip_paort
mode
model
name
parent_id

PAL

{CDSDCDOG-BE2E-EDT 1-BAF3-001AADDAE 3

80
1

Yideo Capture Card 1

T-MAKARDVA

3. Edit the object parameters. To edit the selected parameter, click the left mouse button upon the

corresponding line with its value and edit it.
4. Repeat steps 3-4 for all objects, which parameters configurations are to be edited.
5. Go to the File menu of the control panel and select the Save template item.

Yerifying configuration tool

File | Configuration  Debug

Dovwenload template

| Save template |

6. Name a file and select the storage directory in the appeared window.

Save ir: | (53 My Documents

Y [)backap
1 :5 @Integration Services Script Component
My Recent |- Integration Services Script Task
Documents hﬂMy Music
= hﬂMy Pictures
|_ IC)5naglt Catalog
Desktop 3551 Server Management Studio
[ visual Studia 2008
= ICWorkspace
"/' =] Template1
<t
My Documents | = Template2
My Computer
- File name: |Template§1 e | [ Save ]
MyMNetwark | Saveastpe: | fles [ml) v| [ cancel |

7. Click the Save button.

The template is now created.

9.3.2 Downloading and editing the template

To download and edit the template, do the following:
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1. Go to the File menu on the control panel and select the Download template item.

Verifying configuration tool

File | Configuration  Debug

| Download termplate

Save template

2. Select a template file in the appeared window and click the Open button.

Look i |B My Documnents v| ) F B B

5 C)backap
4 @Integration Services Scripk Component
My Recent [C5) Inkegration Services Script Task
Documents hﬂMy TMusic

- lﬂMy Pictures

=

|_ IC5)5naglt Catalog
erver Management Studio

)s5qL S M b Studi

Desklop
(Cyvisual Studio 2008
|C5) Workspace
=] Template1
<t
My Documents | | = Templatez
=] Template3
My Computer
'__- File name: | A | [ Open ]
MyMNetwork | Files of ype: |l files " ami) v| [ cancel |

The objects tree is displayed as a result. The active checkbox is next to the objects which configuration has
been saved in the template.
= [ Computer

O Long-term archive 1

----- (M| Long-term audio archive 1

-- Yideo Capture Device 1
- [ Audio card 1

----- O Awudio card 2

3. Toedit the template, repeat steps 1-7 of the Creating a template section.

The template is now downloaded and edited.

9.3.3 Verifying and correcting the configuration

To verify the current configuration of objects in Axxon PSIM software and restore it from the template, do the
following:

1. Download the template for which the object configuration is to be verified in Axxon PSIM software (see the
Downloading and editing the template section).
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2. Go to the Configuration menu on the control panel and click the Verify button.

Yerifying configuration tool

File | Configuration | Debug
= |:|| Werify
Carreck
— -
[]videogate 1

[] Configuration check 1

As a result the objects which current configuration in Axxon PSIM software differs from that one in the
template will be marked red in the objects tree.

¥erifying configuration tool

File  Configurakion

= [+] LOCALHOST
Active archiving 1

Debug

Yideo Capture Card 1

Configuration check, 1

3. Toview object parameters in the template which values are different from those ones in the Axxon PSIM
software, click the left mouse button upon the object marked red in the objects tree and go to the
parameters from the template field.

4. Click the Distinguish button in the Template field.

Template

C

Distinguizh ) [ Comrect

As a result the parameters which values are different from those ones in Axxon PSIM software are moved to
the Differences list.

@z
®==

A

B Di
Bl

Yideogate D-

El Parameters from template

drives
flagz
quid
parent_id

guid

\idizk_namehzharet

{EAAEE739-062E-ED11-BAF2-001AADDAE 3BC}
T-MAKAROVA

5. Correction (if necessary) of these parameter in Axxon PSIM software for those ones from the template may
be performed in two ways:
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a. Click the Correct button in the Template field.

Template Digtinguigh ] l'

b. Go to the Configuration menu on the control panel and select the Correct item.

Verifying configuration tool

Configuration | Debug
= Yerify
Carreck
(|

The parameter configuration from Axxon PSIM templates is now verified and corrected.
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10 Index.exe utility for reindexing archive files

10.1 The purpose of Index.exe utility

Index.exe utility reindexes archive files with big data array without restarting the Axxon PSIM™ software.

(@ Note.

Another way to perform reindexing of archive files is to shut down the Axxon PSIM software and delete the
INDEX folder in the VIDEO folder on the disk with archive. Indexes will be rebuild automatically after the
Axxon PSIM startup. This method is equal to using of the index.exe utility.

10.2 Starting and shutting down the utility

To start reindexing utility run index.exe executive file in the Modules64 folder that is in the catalogue of the Axxon
PSIM™ software installation, for example, «C: \Program Files\Axxon PSIM \Modules64».

As a result the window of index.exe utility is displayed
: ) Archive indexing o ] |

| rDisks for reindexing——————————
I e m= ms me [ select al

[~

To stop working with index.exe utility click «Close» - x|

10.3 Using the Index.exe utility

A Attention!

Before you start working with the utility check the value of IndexRebuilding parameter in HKLM/
SOFTWARE/AxxonSoft/Axxon PSIM/Video for 32-bit systems (HKLM/SOFTWARE/Wow6432Node/AxxonSoft/
Axxon PSIM/Video for 64-bit) section of OS Windows registry: by default it should be 0. If the parameter
value differs from the value by default, you should change it to 0, otherwise the utility will not idex the
archive.
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To reindex archive files after its changing (for example, after copying new video recordings to one or several archive
disks), do the following:

1. Startindex.exe utility (see Starting and shutting down the utility section).

2. In appeared window select archive disks for reindexing by setting checkbox next to required disks (1). Check
Select All to set all checkboxes (2).

3. Tostart reindexing click the Start button (3).

I

—Disks for reindexing
p '::'l, IF E:'l, IF F:'l, p Z:'l, r Seleck all
1 2
3 Start
[ 4
Rebuilding, please wait ... "
Drive: C:\... OK! [Time: 00:00;00] 5 _I
Drive: E:\... 8 %

(@ Note.

At the time of reindexing all the elements of utility window are not active.

4. Rebuilding process is displayed by progress bar (4) and in the text field (5).
5. When you finish reindexing, shut the window of utility.

Reindexing of archive files is completed.
To reindex archive files without using the dialog box, in the command line start index.exe utility with parameters,

forinstance, index.exe C, D command will reindex archive files on disks C and D. To reindex archive files on all disks,
use the all parameter.
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11 The shedule.exe utility for creating a replication query file

11.1 The purpose of the shedule.exe utility

The shedule.exe utility is designed for creating a query file on the Server-Receiver while replicating the archive on
unconnected Servers (see Replicating archive from unconnected servers using the removable storage section).

11.2 Starting and shutting-down the schedule.exe utility

To start the utility start the schedule.exe file in the Tools\Replication folder of the Axxon PSIM™ installation
directory. For example:

C:\Program Files\Axxon PSIM\Tools\Replication\shedule.exe .

& Replication =laixi
File Edit ‘ew Favorites Tools Help ‘ t','
- —
( =
e Back - Q - L? /_) Search 1~ Folders v ﬂ Folder Sync
Address Ib :'\Program Files\Intellect! Tools|Replication j Go

==y oo shedule
File and Folder Tasks & "I’l UshTool ‘ shedule '
1 I

=) Make a new folder

e Publish this Folder to the F
Web B cs.di
X 4.8.3.1049

[ share this Folder

shedule.exe
¥ML Configuration File
ZKB

»

Other Places
) Tools
(5} My Documents
:J My Computer
W My Network Places

Details ¥

As the result the dialog window of the schedule.exe utility is opened.
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o
File
Query executor:
[User 1 [ | add_ | D= |

Query
Computer: Camera:

[LocaHosT =l =l
Time period
’7me‘ To:

1406201314 | [1406201314 =]

Corrr.x.ler | Camera

() Note.

The error message is displayed at opening the schedule.exe utility when users or the Camera objects are
not created in the Axxon PSIM™ software under the Computer/LOCALHOST object corresponding to the
Receiver. It is needed to create required objects and restart the system.

To close the schedule.exe utility, click the X button or select Exit in the File menu.

ﬂ% Replication tasks management
File |

Cpen file
Cpen disk
Save Cil+5

G

i kA — j

11.3 Using the schedule.exe utility

11.3.1 Creating the query file for replication
To create the query file do the following:

1. Connect the removable storage to the Receiver.
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2. Select the user registered the Axxon PSIM™ software in the Query executor drop-down list (1).

R
File
Query executor: 1 7
Qe DD €D
CQuery

er: 2 Camera: 3
dl LOCALHOST IC =D

Time period
From: To:
14-06-2013 14 £| [14-06-2013 14 2)4

| From | To
2013-06-14T14:00:00.00000 | 2013-06-14T14:00:00.00000

w

Select the Computer object corresponding to the Data source in the Computer drop-down list (2).
In the corresponding drop-down list select the Camera object the archive of which is to be copied (3).
5. Specify the time period for which the archive from selected camera is to be copied in the From: and To:

>

fields using the mask or calendar that is displayed by clicking the Z‘ button (4).
6. Click the Add button (5).
The task is added to the list (6).

(@ Note.
Select the task and click the Delete button to delete it from the list (7).

7. Repeat steps 2-6 for all required Sources.
8. Save the queryfile.

The query file is now created.

11.3.2 Savingthe query file

To save the query file do the following:
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1. Select Save in the File menu.

Replication tasks management

File |
Open file
Open disk
| save culis
) C
Exit
|—ILUL-J'||L'I AT j F

2. Select the removable disk where the query file is to be saved in the drop-down list of the opened dialog box

(1).
x

{|G:% [FAT3Z] - Becero 14,71 16, Ceofogno 14,13 16

() Note.

The Removable disks are not found message will be displayed if the removable storage is not
found while saving the query file.

(@ Note.

If there is the Axxon PSIMBackup folder on the removable storage, then the dialog box asking to
delete this folder is displayed. Click the OK button .

x

% Folder G:\IntellectBackup found.
j.-' It must be removed to record a new task.
Would vou like to continue?

Ok I Cancel

3. Click the OK button (2). The query file is saved on the selected disk.

The query file is now saved.

11.3.3 Opening the query file
To open the query file do one of the following:

1. Specify the disk where the query file is. For this:
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2. Select Open disk in the File menu.

Replication tasks managen

File |

Open file I

o]
Save Cirl+s

Exit —

AT AT
|—I

3. Select the query file in the drop-down list (1).

; x

|G [FAT3Z] - Beero 14,71 16, CecbogHo 14,13 T6

() Note.

The Removable disks are not found message will be displayed if the removable storage is not found
while openning the query file.

4. Click the OK button (2).

The utility detects and opens the query file which is in the root of selected disk.
5. Select the query file manually. For this:
6. Select Open file in the File menu.

Replication tasks managen

File |

| Open file

Open disk
Save Cirl+s

Exit —

AT AT
|—I

7. Select theitv_task.xml file containing the query parameters using the standard opening dialog.

The query file is now opened.
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12 The Cam_title_updater.exe utility to convert titles database

12.1 Purpose of the Cam_title_updater.exe utility

The Cam_title_updater.exe utility is used to convert titles database to a new format when updating to Axxon PSIM
4.10.x from older versions.

12.2 Starting and quitting the Cam_title_updater.exe utility

Start the Cam_title_updater.exe utility as follows:

1. Start->All Programs -> Axxon PSIM -> Tools -> Update titles DB.

OR
2. <Axxon PSIM installation folder>\Modules using Cam_title_updater.exe file.

The Cam_title_updater.exe overview is shown below.

=101

Convert titles database to 4.10.X

| |pdate database I |

[T Clear old version data at finish

12.3 Updating titles database using the Cam_title_updater.exe utility

Start titles database update as follows:

1. Startthe Cam_title_updater.exe utility (see Starting and quitting the Cam_title_updater.exe utility).

I Cam_title_updater S X

Convert titles database to 4.10.X

Convert data ] |

Delete old data |

2. Click the Convert data button (1). Data conversion to new format will start.

(@ Note

The conversion of receipts is performed by hundreds: each 100 receipts' data are entered into the
new spreadsheet, then deleted from the old.
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3. The process will be visualized by a progress indicator (3).

Cam_title_updater ‘ '

Convert titles database to 4 10X

[ Cancel ]

()
[51]
.'|!
5]
[l
o]
o

4300 of 377247, estimated time left: 02:28:26

(@ Note.
To stop the conversion process, press Cancel buttom. All data converted before you pressed the
button will become accessible.
After a successful update of the Titles Database, you will see a Finished! sign in the (3) area.
To clean up old-format only titles from the database, do the following:

1. Pressthe Delete old data button (2).
2. Press OKin the Warning dialog box.

I.-” \I Old version data will be erased!
W Areyou sure?

All old-format titles will be cleaned up.

The Titles Database is now updated.
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13 The SyncProtocol.exe utility to synchronize event log
database

13.1 The purpose of the SyncProtocol.exe utility. Starting and shutting-
down the utility

Purpose

The SyncProtocol.exe utility is designed to synchronize Server/Client Event log database with databases of
other Servers/Clients by command if the auto synchronization is disabled.

The auto synchronization is disabled on the Computer settings panel using the Only local protocols checkbox. If
this checkbox is set checked, then the auto synchronization is not performed - see Configuring events logging.

Before starting synchronization using the SyncProtocol.exe utility it is required to configure synchronization on the
Computer settings panel by specifying the computers for synchronization and the Event Viewer database
connection string - see Configuring the Event Viewer databases synchronization.

There is no synchronization with computers for which sending events is disabled in the Architecture tab

(see Configuring the interaction of distributed system components. If the Send events checkbox is set checked, but
checkboxes for all the events are set unchecked, then the events that cannot be disabled will be synchronized (for
instance, SLAVE and macro events).

Starting and shutting-down the utility

Start the SyncProtocol.exe utility from the Tools folder in the Axxon PSIM installation folder (by default, C:\Program
Files (x86)\Axxon PSIM\Tools\).

The utility dialog box is shown in the figure.

Synchronization of protocols by means of SQL Servel 5[

| Synchronize I

Synchronization log:

" of

To shut down the SyncProtocol.exe utility click the X button in the upper-right corner of the window.

13.2 Synchronization of event log database using the SyncProtocol.exe
utility

Synchronize the event log database using the SyncProtocol.exe utility as follows:
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1. Preconfigure the system and start the SyncProtocol.exe utility (see The purpose of the SyncProtocol.exe
utility. Starting and shutting-down the utility).

2. Click the Synchronize button (1).
Synchronization of protocols by means of SQL Server x|

| Synchronize 1 I

Synchronization log: 2

Add linked server:5-JAKEEW\SQLEXPRESS2014 d
Ok SQLEXEC sp_addlinkedserver 'S-JAKEEV,SOLEXPRESS2014','SCL Server'
Add linked login:sa

Ok SOL:EXEC sp_addlinkedsrvlagin '5-JAKEEYISOLERPRESSZ014', False’, MULL, *
Svnchro From: 3-JAKEEVISOLEXPRESSZ014.intellect to (local)\SQLEXPRESSZ014.i
0K S5QLiselect * into PROTOCOL_TEMP From [S-JAKEEVYSQLEXPRESSZ2014].inte
Ok SQLICREATE NOMCLUSTERED INDEX [I¥_protocol_pk] OM [dba] [PROTOCOL
OF SOL:CREATE NONCLUSTERED IMDEY [I¥_protocol_pk] oM [dba].[PROTOCOL
©F SOL:EREC sp_droplinkedsrviagin 'S-J8KEEW\SOLEXPRESS2014', MULL

Ok SOLEXEC sp_dropserver 'S-JAKEEVISCLEXPRESSZ014

End

Bl ¥
[
|

3. Theinformation on the synchronization process is displayed in the Synchronization log field (2).
4. When the process is completed shutdown the utility by clicking the X putton.

The event log database is now synchronized using the SyncProtocol.exe utility.
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14 User's Manual for ArpEdit

14.1 Introduction into User's Manual for ArpEdit

On the page:

+ The purpose of
the document

+ The purpose of
ArpEdit

14.1.1 The purpose of the document

The User’s Manual for ArpEdit is a reference tool and contains information needed to work with the ArpEdit. This
utility is included in the basic distribution of the Axxon PSIM software package.
The following materials are included in this manual:

1. General information on ArpEdit.
2. User guidelines for ArpEdit.

14.1.2 The purpose of ArpEdit

ArpEdit is designed to perform the following functions:

1. Creating badge forms for the Access Control Service module (in the form of files with the .arp extension).
2. Creating user dialog boxes (in the form of files with the .dlg extension).

() Note.

The dialog box is connected to Axxon PSIM via a system operator object query window and displayed as a
result of the macro commands that are specifically designed to work with this dialog box. Thus, the ArpEdit
utility allows you to completely adapt Axxon PSIM to solve particular problems of control and security at a

production facility.

14.2 General principles of operating ArpEdit

14.2.1 Starting and shutting down ArpEdit

Launching ArpEdit can be done in one of the following ways:

1. Launch from the Axxon PSIM installation directory. To launch the ArpEdit utility from the Axxon PSIM

installation directory, follow these steps:
a. Go to the folder where you installed Axxon PSIM (default directory is C:\Program files\Axxon PSIM).

b. Gotothe Tools\Arpedit folder.
c. Launch the file arpedit.exe.
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2. Launch from the Start menu. To launch the ArpEdit utility from the Start menu, select the menu item Create
dialog box, located in Start -> Programs -> Axxon PSIM -> Utilities.

Microsoft Update

=

Microsoft Update Catalog

Set Program Access and Defaults

‘Windows Catalog
QIP 2012

RC-WinTrans 9.1

] Qe

Programs

1 Documents

@ Accessaries 2
I Intel Metwork Adapters »
@ Microsaft Office 3
I Snaglt 8 »
é Internet Explorer

@ Skype 3
I qIP 201z »
@ Mozilla Firefox

I 2rmc »
I FreeCommander »

@ Mozila Thunderbird
IF) Microsoft SQL Server 2005 3
IFT) Microsoft SQL Server 2008 R2 ¥

B Intellect 3
¥

Settings 3
I‘J Search 3
u. Help and Support
S Run...
HOI Shut Down, ..

i Start

Closing the operation of the ArpEdit utility may be done in one of the following ways:

1.
e Uintitled - ARP Editor ¥1.1
File Edit Yiew
MEW, .\ Chel+M i E‘
CIpen. .. Chrl+0
Save Chrl+5
| m—
Save As...
Garid's Prink
Recent File
2. click Xl

@ Help
& Tooks
Collect system's data

~1

L
B45) 1TV EXPERT

ﬁﬂ Remove

@s Reparts subsystem

Intellzct

» |
3 :mi Advanced settings ukility
[] Check digital signature

FPS test

U3 Read hardware codes
Read Matrix codes

™ Restors file system indexes
7% Search for IP devices

@ Syskem configuration

41 update DB

B

Video player and file converter

Loca

In the system menu of the ArpEdit utility, in the File heading, select Exit.

If the document contains any unsaved changes, a Report editor dialog box appears.

Report's editor

L] "_n,, save changes to Untitled?
[ ]

Yes Mo

x|

| Cancel

To confirm the changes, click Yes. To exit the program without saving the changes, click No.
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The utility window will close.

14.2.2 Description of the interface elements of the ArpEdit utility

The ArpEdit utility window contains the following key interface elements:

() Note.
More information on the interface elements of the ArpEdit utility can be found in the appendix (see
APPENDIX 1. Interface elements of the ArpEdit utility).

1. The System menu. Provides access to file operations, editing functions and window display settings for the
ArpEdit utility (1).
R =l

Fie Edit Wiew ) 1

NEFIEEI EEE DO EENEREEEEEDE

UM 4,

eady

2. Toolbar. Provides access to key features of the utility (2).
3. Workspace. Contains elements of the badge or dialog box, add users, and allows for the management of

placement and sizes (3).
4. The status bar displays information about the actions produced by the utility (4).

14.2.3 Creating ArpEdit objects
ArpEdit objects are divided into the user interface and variable elements. To create a new object in the workspace,
follow these steps:

1. Select a section of the workspace where you want to add an item, click on it. The selected part will be

highlighted in blue.
n|e(8|[5 o [F of 2] u(n] ufs(—{ | ols(=(\] =] £ 2] o[m]=]

User's Manual for ArpEdit- 116



PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

2. Go to the ArpEdit toolbar.

0|s(@| 6 of A ol £ =|s| @ T EEE ¥ 4 2le| olsl=|

3. Select the object to be added by clicking the left mouse button on the appropriate icon on the toolbar (see
description below).
4. Click the left mouse button at the point in the workspace in which to place the upper left corner of the

object.

() Note.

The dimensions of the created object can be changed in two ways:
1. Bydragging the right or bottom edge of the object with the mouse.
2. By setting new values for the height and width of the object in the field box (see Setting field
variables).

The position of the created object can also be modified in two ways:
1. Dragging the object with the mouse from the top or left edge.
2. By setting the new position of the object in the field variable window (see Setting field variables).

ArpEdit objects:
H
Name
Text
ab|
Name

Variable

=N
=

Frame

Description

Fixed text field

Description

Variable text field, hidden text box, button

or drop-down list.

Description

Aline of given length and direction

Description

Set rectangular frame sizes

Purpose

Display fixed text field

Purpose

1. Displaysinformation from the
database when creating badges;
2. Variable when creating dialog boxes

Purpose

Design element

Purpose

Design element
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L]

Name Description

Square Set filled square sizes

Name Description

Image Image placed at a specific location

Creating a new object is finished.
14.2.4 Setting object display variables

Setting field variables

To set the field variables, follow these steps:

Purpose

Design element

Purpose

Insert client photographs in the badge form for
printing

1. Inorderto set the field variables, it is necessary to select the variables of the object in the workspace, and

open the Variables field in one the following ways:

=
a. Click —| on the toolbar;

b. Inthe object functional menu, select Properties.

() Note.

The object functional menu is opened by right-clicking anywhere inside the object.

Properties

Fonk, ..
Calar,..
Background calar

Remove
Copy
Faste
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2. The Field variables window will appear.

Fildsoptions

Alignment
% Standard
0 Left 3
" Rlight

4 SC»
7

Al H: |0

(I Wfidth it s_uml:n:nls)

ine's thicknesz

i Eenterey

AN

| Grougd 12
Term
{* Egual to zemo £ More than zero
i ME
0 Zerd 15 Lesz than zero

Fisld. | 0 ok D concel |

3. Inthe text field (1) enter information describing the field:
a. Entertextin Text field, which will be displayed in the text field.
b. ForVariable, enter the variable name.
c. ForanlImage, enter the image address in quotes. The image must be placed in one of the following
folders:
i. Inthe Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon PSIM), then in the
field (1) enter the image name, e.g. “image.bmp”.
ii. Inthe Bmp folder of the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon
PSIM\Bmp), then enter the image file address as "Bmp\image.bmp" or "Bmp/image.bmp".
4. If you would like to fill in the text field with data from a text file or enter a large amount of data, then click the

—I button (2) and use a text editor (see the section in APPENDIX 2. Entering text using the editor).
5. Set the Alignment settings for the desired justification of the text within a selected object (3).
6. Select units of measure which will be used to size the object:
a. Ifthe size of the object will be given in millimeters, then check the in mm box (5).
b. If the size of the object will be given in characters [symbols], then check the Width in symbols box

(9).

(@ Note.

The size of the object is given in characters [symbols] by default.

7. Setthe position of the upper left of the object in one of the following ways:
a. Specify the absolute coordinates of the object. In this case you should indicate the position of the
upper left corner by setting the X-axis in the X field, and the Y-axis in the Y field: (6)
b. Specify the relative coordinates of the object. In this case you should check the Relative box (4).
8. The width and height of the object can be set in one of the following ways:
a. Specify the width of the object in the W field, and the height of object in the H field (7).
b. Specify the coordinates of the lower-right corner. To do this, check the X2, Y2 box (8). The Wand H
fields will be by X2 and Y2. After this, specify the coordinates of the lower-right corner of the object
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using the X2 field for the x-axis and the Y2 field for the y-axis.

x
| L

— Coordinates — Alignment
™ Relative ™ inmm % Clamdard
% [31 v: o © Left

Gz o vz [0 )| € ok
™ %2v2 [ ‘widthin spmbols | | © Centered
Line's thickness IIJ [ Hidden

[ Group

— Termn
{* Egual to zemo £ More than zero
" ME to zera ' Less than zero

Field... | k. I Cancel

9. Specify the line thickness in the Line thickness field in the desired units (10).
10. If a custom object should be on the badge or there is a dialog window, but it should not be visible to the
user, then check the Hidden box (11).
11. Ifthe object must be part of a group, check the Group box (12).
12. Click OK (13).

Setting the variables is completed.

Setting the text font
To set the text font, follow these steps:

1. Select Font from the menu...
Properties
Color...
Background calar

Remove
Copy
Faste
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2. Using the standard font selection menu, set the text display settings.

Font 2 x|
Fant; Fant ztyle: Size:
IHegular | (] 4 I

(} @anal Unicode M5 a a “

H @Batang [ talic 9 Lancel |
T @B atangChe Eald 10

H @Daotum Bold Italic 11

% @0 atumChe 12

EGELlim 14

H @GulimChe =l 16 =
— Effects ~ Sample

[T Stikeout

[T Underline

Calar:

I- Black j Script:

Setting the text font is completed.

Setting the color
To set the color, follow these steps:

1. Select Color from the menu.

Properties
Fonk. ..

Background calar

Remove
Copy
Faste
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2. Using the standard color selection menu, select the color desired for the object.

s )

]-luscl_ Red [0
satl_ Green: [0

Defiree CustomColore > | Colorl3olid Lu'h:l_ BMB:]_
ok | Cconcel | Add to Custom Colors |

I"l:llur

Setting the color of the object is completed.

Setting the background color of the object
To set the background color of the object, follow these steps:

1. Select Background color from the menu.
Properties
Fonk. ..
Color. ..

Background caolar

Remove
Copy
Faste
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2. Using the standard color selection menu, select the background color desired for the object.

u1ur
Basic colons:

M
Il il U0
il § Il 1
sl PNl
EEEEEEEN
O

Custam colors:

| 0 5 N
Hue:l_ Red [0
mEEEEEENN Sal.l_ .

Defiree Custom Colors >» | Colorl5obd Lu'n:l_ Bh,le.[_
ok | Cconcel | Add to Custom Colors |

Setting the background color of the object is completed.
14.3 Creating dialog boxes

14.3.1 Creating a dialog box form
In the Axxon PSIM dialog box, objects will be displayed in the ArpEdit workspace.
Create a dialog box form in the following order:

1. Create design elements in the workspace.
2. Create variablesin the workspace.
3. Configure the design elements in the workspace.

Create design elements

The design element types in the dialog box correspond to their appearance on the workspace. You can add the
following design elements to the dialog box form:

1. Square. Adding a square in the workspace is done by clicking on the !l on the ArpEdit toolbar (1).

DlzlEl [T ol Al of #7 8(u] sj=|—[ | cjs@|\] «| 3] 2[2|[5 o]
2 [i]

‘butto

test hel 5 [~ Ikable testhe

‘ on-editabls text fisld nion-editabls 4
C - x>
3 L

[Clozgy

2. Line. Adding a line in the workspace is done using one of the following buttons: J ;| ll on the
ArpEdit toolbar (2).
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Aa
3. Textfield. Adding a text field in the workspace is done by clicking on the —I on the ArpEdit toolbar (3).
1
4. Frame. Adding a frame in the workspace is done by clicking on the on the ArpEdit toolbar (4).
Creating design elements is completed.

Creating variables

ah
Creating variables in the workspace is done using the —| on the ArpEdit toolbar. Depending on the variable
setting they may be displayed in the dialog box as follows:

1. Editable text field (1). Addit_ipnal configuration after adding is not needed (5).

. bin 32

non-editable test figld

N

cloge |

2. Button (2). In order to display a variable as a button in the dialog box, you must configure it after adding it to
the workspace, as follows (6):
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a. Click El on the toolbar. The Field options window will open.

Il Field’s options ) x|

Fisld TColose DI Moredit ™ Hidden
Diefault Y alue _ [ Py, value [~ i
Calculation formula 2 (]"DIALOG ™1 ""CLOSE] |
{* String i |ntegral |' Monetany it
r [ate r Feal I_ Time
™ Pulldown list I™ Logical
I Fill with DB/ table

List fillng |

Dictionaries

L

] |
[

Linkz with another documents

|
I

Field'z dividing
]
[T List OF. I Cancel |

b. Place a colonin front of the variable name (1).

c. Inthe Calculation formula field, specify the variables for the DoReact function using quotes “,” -

which will be used with the button is clicked (2).
d. Click OK.

b

3. Drop-down list (3). In order to display a variable as a drop-down menu in the dialog box, you must configure

it after adding it to workspace, as follows (7):

a. Click El on the toolbar.
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b. Double click on the frame around the variable name. The Field options window will open.

IM [~ Maon-edi

Field

Default ¥ alue

x|

[ Hidden
[ Autogain

I [ Prev.value

{* Sting
" Date

Qv Puldown lizty 1
[~ Fill with DB table

Calculation formula

= |ntegral
" Redl

Lizt filling | +aluel lvaluelvalues

L

[ tonetan unit

[ Time
[ Logical

Dictionaries

| | | |
[

Links with anather documents

I
7

Field's dividing
]
[T List k. I Cancel |

o

Check the Drop-down menu [Pulldown list] box (1).

d. If you would like to manually specify menu values, then you must enter the desired value in the Fill

list field, using the character

((l))

or to paste text from afile, click ==
using the editor).
e. Click OK.

Creating variables is completed.

Setting up workspace objects

as the separator between values (2). To enter a large amount of text

and use the editor (see the section in APPENDIX 2. Entering text

After adding interface elements and variables to the workspace, it is necessary to configure them. Configuring
interface elements includes specifying their display variables (see the section on Setting object display variables).

To configure a variable, follow these steps:

|
1. Click —| on the toolbar.

2. Double click the left mouse button on Variable menu item that you wish to set. The Field options window

will open.
3. Enter the name of the variable in the Text field (1).
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() Note.

If there is a colon in front of the variable name (for example :var), the when creating a dialog box it
will be displayed as a button with the same name (var). At the same time, in the Calculation
formula field (3) the variables for the DoReact function will be displayed, delineated by the “|”

character.
A x|
Field 1z T T

Diefault Y alus 2 0 D[ Prevvale [ Autogain

Calculation farmula
3 + String " Integral
D ate " Real

[~ Pulldown list
= Fill with DE tatble

List filing |

Dictionaries

| | | |
[

Linkz with another documents

|
7

Field's dividing

[ ]
[

- L 7Q T Y cweel |

4. Enter the Default value in the field, of the variable that will be the default value (2).

Set the switches (3) to the position corresponding to the type of variable.

6. Specify the format for the variable. To do this you need to check one or more of the checkboxes in front of
the format corresponding to the variable (4).

7. If you do not want to allow the value of the variable in the dialog box to be changed, then check the Non-
edit box (5).

8. If you want the value of the variable to be present in the dialog box, but not visible, then check the Hidden
box (6).

9. Click OK (7).

o

Configuring variables is completed.
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14.3.2 Saving the dialog box form
To save the dialog box form, follow these steps:

1. Select File, then click Save (1) or Save as... (2) to save the file under a new name.

&1+ 2.dlg - ARP Editor ¥1.1
File Edit View
Mew., .. Ckel+I |
Jpern. .. Chrl+C E‘
Csaved 1 chrl+s
2

Garid's Prink

1Z.dg
Z21.dg

Exxit

I
2. Using the standard save file dialog, save the file with a .dlg extension [suffix].

saveas el
Savein:llﬂ'Dialngs j ) ¥ 2 [~

1.|:II|;|
2. dig

File name: {lbuttnn.dlgl Save I
Save as lype: I,-i'-.ll Files [*.%] j Cancel |

i

(@ Note.

The file extension should be entered manually in this case.

& mportant!

In order to have access to the saved dialog form file in Axxon PSIM, it should be saved in the following
folder: <Path to installation directory of Axxon PSIM>/Program.

Saving the dialog bog form is completed.

14.3.3 Accessing the dialog box from Axxon PSIM

To access the dialog box from Axxon PSIM, follow these steps:
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1. Create an Operator query window under the Computer object in the Hardware tab of the Configure
systems menu.

B2 LOCALHOST

- [B] Honeyell 1000 1
(G Operator’s query pane 1)

& mportant!

When you create an Operator query window in the number field you should specify the name of the
saved dialog box form in the relevant director.

Hurmber I 1

M arme IEIperatu:ur"s query pane 2

LOCALHOST |

2. Go to the settings panel of the Operator query window.

- IDperator“$ query pane 1

Carmpuiter [ Dizable
|LOCALHOST

R .S P, £ K AL

3. Specify the window coordinates: in the X field specify the coordinates along the horizontal axis, in the Y field
specify the coordinates along the vertical axis (1).
4. From the drop-down menu, in the Type column, select the type of object that trigger a dialog box (2).
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5. From the drop-down menu, in the Number column, select the number of selected objected types (3).
6. Double click the left mouse button on the Name column (4). The cell will be automatically completed with

the name of the selected object.
7. Specify the action to be performed upon the occurrence of a specified event, in the Event column (5).

() Note.

In the example shown in the illustration above, the dialog box, created in the form, will be displayed from

the macro.

| button
ket field

non-editable text field

list I waluel - I

close I

Dialog boxes are used for programming the Axxon PSIM software package. More information on the built-in
programming language can be found in the Axxon PSIM Software Package. Programming Guide.

Configuring the Operator query window is described in detail in the Administrator's Guide.

14.3.4 Example of creating a dialog bog to count the number of movements

This section provides an example of how to create a dialog box to count the number of movements. To create such
a dialog box, follow these steps:

1. Create atext field with the text Number of movements [Alarms:] (1).

Alarms:

param

2. Create variables (2).

3. Click El on the toolbar.
4. Double click on the frame around the variable name. The Variable field window will open.
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5. Forthe name of the variable, name it param (1).

Il Field's options

© o N

: 1 ~, 2
Field param v Mon-edit

Default ¥ alue

Calculation formula

R
™ Hidden
I [ Prew.value [ Autogain
{* Sting = |ntegral ™ Monetary unit
" Date " Beal [ Time
™ Pulldown list I™ Logical

™ Fillwith DB tatle

List filing |

Dictionaries

L

| |
[

Links with anather documents

I
7

Field's dividing
]
[T List k. I Cancel |

Check the Non-edit box (2).
Save the file with the name motion.dlg in the following folder: <Axxon PSIM installation directory>\Program

Run Axxon PSIM.

Create a directory try for the Operator query window in Axxon PSIM with the number motion.

Mumber II'I'IDtiDr'I

Mame IEIperatu:ur"s query pane 2

LOCALHOST

1
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10. InAxxon PSIM create a Program under the Programs tab in the Programming dialog box of System

.
settings (1).
piae) [aiae] (i) (o) [frmemna) » I B =
. Ce
settings [ [Pregam ==

: Computer | Name |

-0 Working Periods ™ Disable ws3 LOCALHOST

(D) Working schedules

&-mj Working Schemes 3

58 e I i

=

T

1 OnInit () ( A
paraw="0";

y
OnEvent ("CAM", "1, "MD_START") {

[DoReact {"DIALOGH, "ot 1on", "CLOSEM) ;

param=str (atof (param)+1] ;

oReat ("DIALOG™, Mmotion™, "RUN™, "param<™ + paraw + ") ;

+
e —| >
L 2

G

11. Write the following code (2):

onInit(){
param="0";
}

OnEvent ("CAM","1" "MD_START"){

DoReact ("DIALOG","motion","CLOSE");

param=str (atof(param)+1);

DoReact ("DIALOG","motion","RUN","param<" + param + ">");}

12. From the drop-down Time zone menu, select Always (3).
13. Click Apply (4)

This script indicates that if the video camera in sector 1 detects movement, then a motion operator query window
will open, showing the number of movement alarms (param).

Alarms:
Fi

14.4 Working with badge forms

The ArpEdit utility supports work with the Visitor Management System (see Visitor Management System Module
Settings and Operation Guide) module and allows you to create badge forms and output them for printing.

14.4.1 Creating a badge form

Before you start to create badge forms, you need to make sure that you have created an Access Control Service
object, as well as departments and users in Axxon PSIM.

To create badge forms in the Access Control Service, follow these steps:

1. Select the workspace section where the items will be added to the interface. Each section represents a single

page.
2. Create the required number of variables, as follows:
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a. Add avariable to the workspace by clicking on the toolbar (1).

-2 - ARP Editor v1.1
File Edit View

PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

=101 ]

: D| L7 mm| afan| |

3

<

e

Mame
nanm
j 2

Department

IECENEREEEEE
1

| Access level |

level

Ready

b. Click El on the toolbar.
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c. Double click the left mouse button on the border of the Variable that you wish to set. This will open
the Field options window.

Il Field's options x|

Field 1 Naon-edit I Hidden
Default Y alus I [ Prev.value [T Autagain
Calculation formula I |
{* Sting = |ntegral ™ Monetary unit
" Date i~ Feal [ Time
™ Puldown lis I Logical

™ Fillwith DB tatle

List filing | [
Dictionarnies
| | | |
]

Links with anather documents

I
7

Field's dividing

[ |
J

[ List )4 I Cancel |

d. Inthe Field box [field], enter the name of the variable corresponding to the table in the Axxon PSIM
database: dbo.OBJ_PERSON, from which data will be accessed for printing the badges (1).
3. Add the required design elements from the ArpEdit toolbar.
4. Inorder to allow the printing of photographs of employees on each pass for badge users, the Image should
be set as follows:
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5. Select the required Image and click 1' on the toolbar. The Field options window will open.
m

"C:AProgram FilesIntellectBmphPerzony' +id+" bmp ! |

— Coordinates — Alignment
™ Relative ™ inmm % Standard
. I-I N ||:| T Left
w2 [16 vz [10 " Right
W %272 [ widthin symbols | | Centered
Lire's thickness IIJ [ Hidden

[T Group

— Term

¥ Equal to zemo
£ ME to zero " Less than zero

Field.. | [ ok |

6. Inthe Field options window, specify the following text string: “<Axxon PSIM installation
directory>\bmp\Person\"+id+”.bmp” (1). When outputting the badge to the printer, the id variable will be
automatically read from the data base, and photography assigned to that ID by Axxon PSIM will be printed
on the badge.

™ Mare than zero

Cancel

Design elements used for badge forms:

Name Description Function

Text Uneditable text field Will display uneditable text information
ENN

Name Description Function

Line Line of any given length and direction Design element
[=]

Name Description Function

Frame Rectangular frame of a specified size Design element
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L]

Name Description Function

Square Filled rectangle of a specified size Design element

Name Description Function

Image An image placed at a specified location Insert user photographs on badge forms when
printing

After adding all the required elements in the workspace, you must set the display variables (see section on Setting
object display variables).

Creating badge forms is completed.

14.4.2 Saving badge forms
To save created badge forms, follow these steps:

1. From the File menu, select Save (1) or Save as... (2) to save a file with a new name.

o 2.dlg - ARP Editor v1.1
File Edit Wigw

Mew. .. Chrl-+r
Qper. .. kel

Csaved 1 chrl+s
2

Garid's Prink

]

1Z.dg
Z21.dg

Exxit

User's Manual for ArpEdit- 136



PSIM 1.0 (english) - Additional Utilities for the Axxon PSIM Software

2. Using the standard save file menu, save the badge form file with a .arp extension.

saveas 2 x|

Save it I (& Desktop

o & 2 m.

My Docurnents

j My Compuker

' My Metwork Places
Dialogs

File name: Ifu:urm

Save I

Save as type: [ARP Files [*.arp)

j Cancel |

A

Saving badge forms is complete.

14.4.3 Printing badges

To output badges for printing, select Printer network [Print’s Grid] from the File menu.

41 2.dlg - ARP Editor v1.1
File Edit Miew

Mew. .. CkrlH-M
CIpen. .. Chrl+0
Save Ckrl+5
Save As...

t Grid's Prink i

1Z2.dg
Z1.dg

M- |

Ezxit

Outputting the badge to the printer is completed.

14.5 APPENDIX 1. Interface elements of the ArpEdit utility

14.5.1 System menu

The ArpEdit utility system menu provides access to the following functions:
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1. File operations: creating, opening, saving, printing (1).
&1+ Untitled - ARP Editor ¥1.1

(Fiz)Edi)Cizw ) 3
=@l [0 o[ ol
I

Text editing features (2).
3. AprEdit utility window display settings. In this menu, you can enable or disable the display of the toolbar and

status bar (3).

g

14.5.2 Toolbar

The main way to manipulate objects in ArpEdit is via a toolbar, that has buttons to control the utility.

& Untitled - ARP Editor v1.1 -10] x|

File Edit | view

(ol=l®l [C o5 o] &> mn] al=—1] o=@~ o 4 28] o== )

Ready [ [om 4

Description of the buttons in the ArpEdit utility toolbar:
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Button image

Name

[ Function

Manipulation of ArpEdit documents

New Create new document

Open Open file

Save Save text document
Managing an ArpEdit document

Crient vertically

Whenthis element is activated, the page is oriented vertically

Orient horizontally

When this element is activated, the page is criented
harizontally

\m|we|s | HD |05 [Ew]o

Display sections Displays sections (pages) of the document (up to five)
Show grid Displays the mapping grid for the workspace
Snap to grid Snaps the object to the grid
Zoom in Increases the size of objects in the workspace
Zoom out Decreases the size of objects in the workspace
Display options Opens a settings window with display settings for the
selected cbject
123 Sort fields Displays the fields in order by section
Adding objects to the ArpEgdit workspace
ﬁl Text Insert a text field in the workspace
ah Field Insert @ Variable (editable text field) in the workspace
=i Harizontal line Insert a horizontal line in the workspace
| Vertical line Insert & vertical line in the workspace
| Frame Insert a frame in the workspace
| Sguare Insert a square (shaded rectangle) in the workspace
Image Insert an image in the workspace
Sy, Line Insert a line in any direction in the workspace
T Ohject management
G Separate text Separate text using a linefeed as a separator
% Delete Delete the selected object
g Form Access the editor for variable parameters
Form options Set parameters for the connection with the data source

14.5.3 Workspace

The ArpEdit utility workspace is designed for the placement of objects in ArpEdit. When the Show sections button is

activated, the workspace will be divided into sections by horizontal lines.
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=gl x|

SR E ==

DS@ [0 O|[F of S w|s| w1 ojm

Ready

[ T

Each section will have its own page. To start editing a section, select it by licking on the dividing line with the left
mouse button. The selected section will be highlighted in blue.

14.6 APPENDIX 2. Entering text using the editor

You can enter text in the variable settings using the built-in ArpEdit editor. This editor should be used when you

want to fill in a text field with data from a text file or a large amount of data.

To enter text using the editor, follow these steps:

1. Click —I next to the text field.

Field's options x|

®

— Coordinates — Alignmert
™ Relative ™ inmm % Standard
% [18 v: [ " Left
x2: [28 v [ " Fight
¥ %22 [ Widihinspmboks | | ¢ Centered
Line'z thicknesz IIJ— [ Hidden

[~ Group

— Term

{+ Equal to zemo
™ ME to zemo

£ More than zem

" Less than zero

Field... |

k. I Cancel
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2. Open the Editor window.

Wedor 1 X
A
2 Syntax " 3 Cancel |

3. Entertextin the text field (1).
4. If you want to paste the text into a text field from a text file, then click File... (2) using the standard open file

dialog box, select the required text file. Text from the selected file will appear in the text field (1).
5. Click OK (3).

Entering text using the editor is completed.
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15 The Axxon Player utility for viewing and converting the video
archive

Please see the documentation here.
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16 The openRTSP.exe utility for checking RTSP workability

The openRTSP.exe utility is a console application without a graphical user interface. This utility is intended for use
in scripts to check workability of the RTSP Server module. Please visit http://www.live555.com/openRTSP/ for
details about the utility.

The openRTSP.exe file is located in the <Axxon PSIM installation directory>\Tools folder.

An example of a script to test the workability of RTSP is given below. This script runs the openRTSP.exe utility by
timer, then the utility takes 1 sec of video and checks the status of the RTSP Server. If a rejection from the RTSP
Server itself is received, the StreamingServer.run process is restarted.

() Note.

Create and configure the Timer object for the required check period - see Creating and using the Timer
object.

function check_cam(addr)

{
var scmd = "./Tools/openRTSP.exe -V -D 10 -d 1 "+addr;
DebuglLogString("run:"+scmd) ;

var s = run_cmd_timeout(scmd, 10000);

DebuglLogString(s);
if(s.indexOf("Receiving streamed data")< 0)
{
DebuglLogString("restarting");
var msg = CreateMsg();
msg.StringToMsg("SLAVE | COMP_NAME | EXECUTE |
restart<l>,command<streamingserver.run>"); //change COMP_NAME to the name of the
computer where the process runs
DoReact(msg);
}
}

if(Event.SourceType == "LOCAL_TIMER" && Event.SourceIld == "TEST_RTSP")
{
check_cam("rtsp://127.0.0.1:5544/1"); //the link 1is formed as described in the
"Configuring the RTSP Server Module" section
check_cam("rtsp://127.0.0.1:5545/4");
1
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